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Preface

Purpose
Dell™ Compellent™ Enterprise Manager allows an administrator to manage multiple Dell 
Compellent Storage Centers. This guide assumes the user is familiar with basic storage 
concepts and with Storage Center administration.

Related Publications
In addition to this guide, users may need to refer to the following related publications:

• Dell Compellent Storage Center Enterprise Manager Installation and Setup Guide

Provides step-by-step instructions for installing and setting up all Enterprise Manager 
components. In addition, describes how to use the Data Collector Manager and the 
Server Agent Manager.

• Dell Compellent Storage Center System Manager User Guide 

Describes how to use Storage Center Manager to configure and manage storage on a 
Compellent Storage Center.

To download Dell Compellent product manuals, go to:

http://www.dell.com/manuals

Contacting Dell Support Services
Please contact Dell Technical Support Services from the following address if you need 
support assistance:

http://support.dell.com/compellent

http://www.dell.com/manuals
http://www.support.dell.com/compellent
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Introduction
Congratulations on making the move to Fluid Data storage from Dell Compellent. The new 
Fluid Data architecture combines a powerful data movement engine, virtualized software 
applications, and an agile hardware platform to intelligently manage data at a more granular 
level. Get ready to take back your nights and weekends as our patented technology 
optimizes performance, lowers costs, and increases storage utilization.

Enterprise Manager provides comprehensive management and monitoring of local and 
remote Storage Centers. Enterprise Manager consists of the following components:

• Primary Data Collector
The primary Data Collector runs as a service on a dedicated server, collecting data from 
one or more Storage Centers.

• (Optional) Remote Data Collector
In addition to the primary Data Collector, a site can install a remote Data Collector on a 
remote server. The remote Data Collector connects to the primary Data Collector as a 
shadow service. If the primary Data Collector is unavailable, the remote Data Collector 
can activate a DR site.

• Enterprise Manager Client(s)
Enterprise Manager clients can reside on any local or remote PC. A client connects to 
the primary Data Collector to display and manage Storage Centers connected to the 
primary Data Collector service.

• (Optional) Server Agent for Windows
A Server Agent can be installed on each Storage Center server running a Microsoft 
Windows Operating System. Once installed, a Server Agent can register with Enterprise 
Manager and allow Enterprise Manager to collect and report operating-specific storage 
data. In this way, Enterprise Manager can periodically recover storage from Windows 
NTFS.

For complete information on installing primary and remote Data Collectors, Enterprise 
Manager clients, and Server Agents, refer to the Enterprise Manager Installation and Setup 
Guide.
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What's New in this Release

What's New in this Release
Enterprise Manager 5.5 introduces the following features and enhancements.

Feature Description

Support for Storage 
Center 5.5

Enterprise Manager 5.5 supports all features available with the Storage 
Center 5.5 release.

Performance 
Improvements and 
Storage Profile IO 
Usage Reports

Enterprise Manager 5.5 provides performance improvements to the 
Storage Center IO Usage tab. In addition, IO/Sec, KB/Sec, Latency, and IO 
Pending reports are now available for Storage Profiles.
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Enterprise Manager Requirements
All Enterprise Manager components (Data Collector, Database, Server Agent, and Client) 
can be run on either x86-32 or x86-64 processors. For 64-bit processors, only AMD64-
compatible, including Intel 64, are supported. Itanium 32 and Itanium 64 are not supported. 

The following table lists requirements for Enterprise Manager components:

This document assumes you have correctly installed the Enterprise Manager Data 
Collector and at least one client. Refer to the Enterprise Manager 5.5 Installation and Setup 
Guide for installation and setup instructions.

Component Requirements

Data Collector • Microsoft Windows Server 2003 or 2008 with the latest service 
packs

• Minimum 1GB of RAM

• Minimum 20 GB of available storage

• Microsoft .NET Framework 2.0 (included)

• Java Runtime Environment (JRE) 1.6

Database One of the following:

• Flat file (no database)

• MySQL (4.1, or 5.0)

• Microsoft SQL Server 2005

• Microsoft SQL Server 2008

• Microsoft SQL Server 2005 Express Edition

Note The Enterprise Manager Installation CD provides an option 
for installing Microsoft SQL Server 2005 Express Edition.

Note Databases in Microsoft SQL Server 2005 Express are 
limited to 4GB.

Enterprise Manager Client • Microsoft Windows XP or Microsoft Windows Vista

• Java Runtime Environment (JRE) 1.6

Server Agent • Microsoft .NET Framework 2.0 (included)

• Microsoft Windows Server 2003 or 2008 with the latest service 
packs

Note The Free Space Recovery feature works with Windows 
Basic volumes only.
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Starting and Exiting the Client

 To start Enterprise Manager

• From the Windows Start menu, select All Programs > Compellent Technologies > 
Compellent Enterprise Manager > Compellent Enterprise Manager Client. The 
Enterprise Manager login window appears.

 To log on for the first time

For first-time logon, create an Enterprise Manager user and a connection to a Data 
Collector. 

Note If Enhanced Security is enabled, you cannot create a new user when you log on to 
a Data Collector. Contact your Enterprise Manager administrator to get a username 
and password for Enterprise Manager.

1 On the login window:

• User: Enter a user name.

• Password: Enter a password.

• Create New User: For first-time logon, this option is enabled. That is, you must 
create a new user.

• Re-enter Password: Re-enter the password.

• Create New Connection: For first-time logon, this option is enabled. That is, you 
must create a connection.

• Name or Host IP: Enter the host name or IP address of the server running the Data 
Collector.

• Port: Enter the port the Data Collector is using in the Port Field. The port is set when 
the Data Collector is installed. The default port is 7342.

2 Click Login. The Enterprise Manager Explorer is displayed.

3 Click  to add a Storage Center to be managed. See Adding and 
Removing Storage Centers on page 8.

 To log on as an existing user
1 On the logon window, enter your user name and password. 

2 Click Login.

Enterprise Manager retains data collector information from the last login. 
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Starting and Exiting the Client

 To log on and connect to another Data Collector
1 On the login window, enter:

• User: Enter a user name.

• Password: Enter a password.

• Create New User: Enable this option.

• Re-enter Password: Re-enter the password.

• Create New Connection: Enable this option to create a new connection.

• Name or Host IP: Enter the host name or IP address of the server running the Data 
Collector.

• Port: Enter the port the Data Collector is using in the Port Field. The port is set when 
the Data Collector is installed. The default port is 7342.

2 Click Login.

 To exit Enterprise Manager
1 From the Management menu, select Close.

2 If you are prompted to minimize the application, click Yes to minimize Enterprise 
Manager or click No to exit.

Note If you want Enterprise Manager to prompt you to minimize the application to the 
system tray when you close the application, see Setting User Properties on page 12 
to enable this option. Rebooting a PC closes the client application.



8 Enterprise Manager 5.5 User Guide

Adding and Removing Storage Centers

Note If Enhanced Security is enabled, you cannot add or delete Storage Center from the 
Enterprise Manager Client. Contact the Enterprise Manager administrator to add 
Storage Centers to the Client.

 To add a Storage Center
1 From the Management menu, choose Add Storage Center. 

2 Select one of the following:

• Add Storage Center: Select this option to add a Storage Center that does not 
appear in the list of Storage Centers.

• Select Storage Center from list: Select this option to add a Storage Center that 
appears in the list of Storage Centers, and then select the Storage Center from the 
list.

3 Click Next.

4 Enter Storage Center logon information:

• Host Name: For a new Storage Center only. Enter the host name or IP address of a 
Storage Center controller. For a dual-controller Storage Center, enter the IP address 
or host name of the management controller. 

• User Name and Password: Enter an Administrative Storage Center user name and 
password.

5 Click Finish. 

 To remove a Storage Center
1 From the Enterprise Manager explorer, right-click on a Storage Center listed in the 

Storage Centers pane.

2 From the short-cut menu, select Remove. 

3 Click OK.
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Viewing the Main Window

Viewing the Main Window
The composition of the Enterprise Manager Explorer changes depending on actions, 
selections, and user defaults. 

Enterprise Manager displays information for a selected Storage Center or for multiple 
Storage Centers. Single-Storage Center displays are called Views; Multi-Storage Center 
displays and functions are called Viewers.

• Storage Centers: Lists Storage Centers that are managed by Enterprise Manager. 
Click on a Storage Center to display Views for the selected Storage Center.

• Storage Center Views: Display data for the selected Storage Center. The default view 
is the Storage Summary. 

• Viewers: Lists multi-Storage Center Viewers. Click on a Viewer to display views for all 
Managed Storage Centers. For example, click on Threshold Alerts to view threshold 
alerts for all managed Storage Centers.
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Using Storage Center Menus
The following menus are available when a Storage Center is selected in the left Storage 
Center pane. Menus that appear with Viewers are described with the Viewer.

Menu Description
Management Displays the following options:

• User Properties

• Data Collector Properties

• Properties (for selected Storage Center)

• Add Folder

• Add Storage Center

• Remove

• Close

Replication 
Recovery

Displays the following options:

• Save Restore Points

• Validate Restore Point

• Restore/Restart Volumes to Original Storage Center

• Activate Disaster Recovery Site

• Test Activate Disaster Recovery Site

• Predefine Disaster Recovery Site

• Delete Test DR Activated Volumes

Storage Center 
View 

Displays the following options 

• System Summary
• Current Alerts

• Historical Alerts

• Logs

• IO Usage

• Storage Management

• Replications

• Charting

• Update All Visible Tabs
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Using Storage Center Menus

Storage Center Tasks Displays management tasks:

• Edit Settings
• Volume > Create Volume

> Create Multiple Volumes

> Create Volume Folder
• Server > Create Server

> Create Server Cluster

> Create Server Folder
• Replay Profile > Create Replay Profile
• Storage Profile > Create Storage Profile
• Replication > Replicate volumes

> Simulate Replicate Volumes

> Move Volumes

> Import Volumes from External 
Devices

> Create QoS Node

> Configure iSCSI Connections

> Start Replication Baseline
• Export Objects

Help Displays the following options:

• About

• Webhelp

Menu Description
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Setting User Properties
User properties set defaults for the current user. User Properties include:

• General
General properties include setting up an email address for notifications, as well as 
default client application settings, chart markers, and chart colors. 

• Default Views
Default Views properties specify defaults for Enterprise Manager views and viewers.

• Manage Events
Manage Events properties specify the events for which you want to be notified via email.

• Change Password
Change Password allows you to change your user password.

Note To change a property setting, click Change in the lower-right corner of a properties 
display. After making changes, click Apply Changes.

General

 To set up email notification

Email notification instructs the Data Collector to email information and automated reports. 
To use Email, you must set up Data Collector with an SMTP server. For more information, 
see To configure an SMTP server on page 17. 

1 From the Management menu, choose User Properties. 

2 Click General. 

3 In the lower right corner, click Change. 

4 Enter the following:

Email Address: Enter the email address to which to send information.

Email in HTML: Select to send email in HTML format.

Test Email: Click Test Email to send a test email.

5 Click Apply Changes.

6 Click OK to close User Properties

 To set client application defaults
1 From the Management menu, choose User Properties. 

2 From the menu, click General. 

3 In the lower right corner, click Change. 

4 Under Client Application Settings, enable or disable the following options:

• Minimize to System Tray on Close: Automatically minimizes the Enterprise Client 
to the Windows system tray. Default is to prompt before minimizing. 
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Setting User Properties

• Start Application on Startup: Automatically starts the Enterprise Client on system 
startup. Default is to not automatically start the Client.

• Prompt to Minimize on Close: When you close the Client, a window appears 
asking if you want to exit Enterprise Client or minimize the Client to the system tray. 
Default is to prompt to minimize on Close. 

5 Click Apply Changes.

6 Click OK to close User Properties.

 To select chart markers
1 From the Management menu, choose User Properties. 

2 Click General. 

3 In the lower right corner, click Change. 

4 Under Select Chart Markers:

• Show Threshold Alert Levels on Charts: View a horizontal line parallel to the X 
axis, showing the relationship between the reported data and the threshold level. 
The default is to hide threshold alerts.

• Show Storage Center Alerts on Charts: Select this option to show a vertical line 
parallel to the Y axis, showing the relation between reported data and Storage 
Center Alerts. The default is to hide Storage Center Alerts. 

5 Click Apply Changes.

6 Click OK to close User Properties.

 To select chart colors
1 From the Management menu, choose User Properties. 

2 Click General. 

3 In the lower right corner, click Change.

4 Under Select Chart Colors, click on the Modify button next to the color you want to 
change: 

• Background
• Gridline
• Crosshair

5 Select a color:

• To select a Swatch color - Click on the Swatch tab and then click on the color you 
want to select

• To select a color based on an HSB value - Click on the HSB tab and then enter the 
HSB value by identifying hue (H), saturation (S), and brightness (B)

• To select a color based on an RGB value - Click on the RGB tab. Enter the RGB 
value by identifying red (R), green (G), or blue (B)

6 Click OK to close the Select Color dialog
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7 Click Apply Changes

8 Click OK to close the User Properties dialog.New color settings appear the next time a 
chart is updated.

Default Views
Default Views configure:

• Client View: The Client View configures the way in which the added Storage Centers 
are displays in the Storage Centers pane. 

• Default Storage Center Tab: Although you can display a Storage Center window by 
selecting it from the Storage Center View menu, Default Storage Center tabs select 
windows that will open automatically when you open Enterprise Manager. You can also 
choose to view a filter when clicking on a Storage Center tab.

• Default Viewers: Default Viewers select the viewers that are displayed in the Viewers 
pane (lower left corner of the EM window. 

 To change the Storage Centers navigation pane
1 From the Management menu, choose User Properties. 

2 Click Default Views. 

3 In the lower right corner, click Change.

4 Under Client View, select one of the following:

List View: Displays Storage Centers in a list.

Tree View: Displays Storage Centers in a tree.

Menu View: Displays only menus.

5 Click Apply Changes.

6 Click OK to close the window.

 To select the Storage Center tabs to be opened automatically
1 From the Management menu, choose User Properties. 

2 Click Default Views. 

3 In the lower right corner, click Change. 

4 Under Default Storage Center Tabs, select defaults for Storage Center tabs.

5 Click Apply Changes.

6 Click OK to close the window.
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 To select default Viewers to be displayed in the Viewers pane
1 From the Management menu, choose User Properties. 

2 Click Default Views. 

3 In the lower right corner, click Change.

4 Under Default Viewers, click Show next to the viewers you want to show by default.

5 Select a default window to display when viewers are selected. If you show Storage 
Centers, choose a default Storage Center.

6 Click Apply Changes.

7 Click OK to close the window.

Manage Events

 To select events to be emailed to you
1 From the Management menu, choose User Properties. 

2 Click Manage Events. 

3 In the lower right corner, click Change.

4 Select the events for which you want email notification.

5 Click Apply Changes

6 Click OK to close the window.

Change Password

 To change a password
1 From the Management menu, choose User Properties. 

2 Click Change Password. 

3 In the lower right corner, click Change.

4 Enter your user name and password.

5 Re-enter the new password. 

6 Click Apply Changes.

7 Click OK to close the window.
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Setting Data Collector Properties
Data Collector Properties are initially set up during Enterprise Manager installation. After 
installation you can change Data Collector properties.

• General

• SMTP Server 

• Phone Home

• Automated Reports

• Server Agentt

• Schedules

General

 To view general Data Collector information, including licenses
1 From the Management menu, choose Data Collector Properties.

2 Click General.

General Data Collector Information is display only.

Connection Information: Name, host/IP address, and port.

Data Collection Information: Revision level, unique ID, and Java revision level.

Database Information: Database server and JDBC revision level.

License Information: Foundation is the main Enterprise Manager. License Information 
displays the license key. If the system is licensed for additional products, the license 
information indicates True. 
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• For more information about the Reporter, refer to Reports Viewer on page 91.

• For more information about Using Chargeback on page 137.

• For more information about the SMI-S server, refer to the Enterprise Manager 5.3 
Setup and Installation Guide. 

3 Click OK to close the window.

SMTP Server
Simple Mail Transfer Protocol (SMTP) is a protocol for sending email messages between 
servers. Storage Center uses SMTP to send automated emails to an administrators 
account when management is required. 

 To configure an SMTP server

Note Before you can change any Data Collector properties, you must click the Change link 
in the lower-right corner of the Properties window. 

To get email notification of alerts and events to users, set up an SMTP server. (Each user 
must enter his or her own email address (see To set up email notification on page 12).

1 From the Management menu, select Data Collector Properties. 

2 Click SMTP Server. 

3 In the lower right corner, click Change. The SMTP Server Configuration is enabled.

4 Set up the following:

• From Email Address: Enter the email address to display when a user receives an 
email from the Data Collector.

• SMTP Host/IP Address: Enter the host name or IP address of the SMTP server.

• Use SMTP Authentication: Select this option if the SMTP server requires 
authentication.

• User: If SMTP authentication is used, enter the SMTP server User Name. 
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• Password: If SMTP authentication is used, enter the SMTP password. 

5 Click OK to close the window.

Phone Home 
Phone Home sends a copy of a Storage Center configuration to Copilots to enable them to 
support a system. The initial configuration is sent to Dell Compellent when the Storage 
Center system is first installed. If you have questions about your system, Phone Home to 
report your current configuration.

The Phone Home wizard initiates Phone Home process, and displays whether a Phone 
Home process is in progress. To initiate the Phone Home process, Select Phone Home 
Now. If you select Phone Home Now while a Phone Home process is already in progress, 
you will be warned and given the opportunity to restart the Phone Home process. 

Once the initial Phone Home process is finished, you can start another Phone Home by 
selecting Phone Home Now.

The Phone Home wizard displays the status of each of the items that are being phoned 
home. Items that are being phoned home display In Progress. Once completed, this state 
changes to Success if the Phone Home is successful, or Failure if the Phone Home could 
not be completed.

 To enable global Phone Home
1 From the Management menu, select Data Collector Properties

2 Select Phone Home. The Global Reporting Phone Home Defaults window appears. 

3 Click Change.

4 Click Enable Phone Home. 
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5 Select the reports to send: IO Usage, Storage Usage, and/or Replications.

6 Select a period to phone home, such as 4 hours, 12 hours, or daily.

7 Click OK.

Note Setting Global Phone Home properties does not actually send reports to the Data 
Collector. To send reports to the Data Collector, refer to To set phone home options 
for a single Storage Center on page 20.

 To phone home now
1 From the Management menu, select Data Collector Properties. 

2 Select Phone Home. 

3 In the Phone Home window, click Phone Home Now.

4 On the left side of the display, select the Storage Centers for which you want to phone 
home data. In the right side of the display, select the reports to phone home. You can 
return to this window to phone home different reports for different Storage Centers.

5 Select Time Period to Phone Home: Select a time period to phone home or check Use 
Current for the current time and date. 

6 Click OK. The Phone Home window reappears.

7 Click OK to close the window.
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 To set phone home options for a single Storage Center
1 From the Management menu, select Properties. 

2 Click Phone Home. The Reporting Phone Home Settings window appears. 

3 In the lower right corner, click Change.

4 Select either Use the Data Collector Global Settings or Enable Phone Home.

• If you select Use the Data Collector Global Settings, you can change the global 
settings by clicking Edit Global Settings.

• If you select Enable Phone Home, select the reports to include in Phone Home - IO 
Usage (refer to IO Usage on page 46), Storage Usage (Refer to Storage 
Management on page 50), Replications - Refer to Managing Replications on 
page 101.

5 Click Apply Changes.

6 Click OK to close the window. 
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Automated Reports
Data Collector Automated Reports properties set global report settings for all Storage 
Centers managed by the Enterprise Manager client. To set report options for a specific 
Storage Center, see Automated Reports on page 29. For complete information on 
automated reports, see Reports Viewer on page 91.

Server Agent
Data Collector Server Agent properties set global properties for all Server Agents. For 
complete information on Server Agents, see Using the Servers Viewer on page 165.

Schedules
Data Collector Schedules establish schedules for replication restore points and gathering 
data for usage reports.

 To set a schedule for automatically saving and validating restore points
1 From the Management menu, select Data Collector Properties. 

2 Click Schedules.

3 Click Change.

4 Set the following:

Automatically Save and Validate Restore Points: Enable this option to automatically 
save and validate restore points.

Check every/At time: Enter the schedule for automatically saving and validating 
restore points.

5 Click Apply Changes.

 To set a schedule for gathering IO, Replication, and/or Storage Usage
1 From the Management menu, select Data Collector Properties. 

2 Click Schedules.

3 Click Change.

4 Set schedules for automatically gathering IO Usage, Replication Usage, and/or 
Storage Usage.

5 Click Apply Changes.
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Setting Storage Center Properties
Enterprise Manager provides options for changing default properties for each individual 
Storage Center that is managed by Enterprise Manager.

• General

• Licenses

• Preferences

• Storage

• Data Collector

• Phone Home

• Automated Reports

General

 To change a Storage Center name or operating mode
1 In the Storage Centers pane, select a Storage Center.

2 From the Management menu, select Properties. 

3 Click General. 

4 Click Change.

5 In the Storage Center Name field, enter a new name.

6 In the Operating Mode field select Normal, Maintenance, or Install. Selecting Install 
or Maintenance isolates alerts from those that would occur during normal operation. 

7 Enter any notes.

8 Click Apply Changes.

9 Click OK to close the window.

Note Storage Center properties can also be changed by right-clicking a Storage Center in 
the Storage Centers pane, and choosing Edit Settings.
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Licenses

 To view Storage Center license information

This window is informational only. To change Storage Center licensing, contact a Dell 
Compellent representative.

1 In the Storage Centers pane, select a Storage Center.

2 From the Management menu, select Properties. 

3 Click License to display license information for the selected Storage Center system. 

4 Click OK to close the window.

Preferences
Preference properties establish Storage Center user defaults for new volumes.

 To set the default size for new volumes
1 In the Navigation pane, right-click on a Storage Center and select Edit Settings.

2 Select Preferences.

3 Click Change.

4 Do the following:

• Default Volume Size: Enter a default size for new volumes in GB, TB, or PB.

• Show block size option in volume wizards: Enable this option f you want to 
display volume size in blocks.

5 Click Apply Changes.

 To set default cache settings for new volumes
1 In the Navigation pane, right click on a Storage Center and select Edit Settings.

2 Select Preferences.

3 Click Change.

4 Select the following cache options for new volumes:

Read Cache Enabled: Select this option to enable read cache for new volumes.

Write Cache Enabled: Select this option to enable write cache for new volumes.

Allow Cache option selection: Select this option to allow cache options to be selected 
when a volume is created.

5 Click Apply Changes.
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 To set default base volume name for new volumes
1 In the Navigation pane, right click on a Storage Center and select Edit Settings.

2 Select Preferences.

3 Click Change.

4 In the Base Volume Name area, enter a name to use as a base for new volumes. The 
default base is New Volume. 

5 Click Apply Changes.

 To set default Replay options for new volumes
1 In the Navigation pane, right click on a Storage Center and select Edit Settings.

2 Select Preferences.

3 Click Change.

4 Select the following Replay options:

Replay Profile(s): Select one or more Replay Profiles to apply to new volumes.

Minimum Replay Interval: Specify the minimum interval in minutes at which Replays 
can be taken. The default is 5 minutes.

5 Click Apply Changes.

 To set default server operating system for new volumes
1 In the Navigation pane, right click on a Storage Center and select Edit Settings.

2 Select Preferences.

3 Click Change.

4 Select a server Operating System to use as the default for new volumes.

5 Click Apply Changes.

 To set default Storage Profile for new volumes
1 In the Navigation pane, right click on a Storage Center and select Edit Settings.

2 Select Preferences.

3 Click Change.

4 Select the following:

Storage Profile: Select the Storage Profile to use as the default for new volumes.

Allow Storage Profile selection: Select this option to allow the selection of a Storage 
Profile when a volume is created.

5 Click Apply Changes.
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 To set default Storage Type for new volumes
1 In the Navigation pane, right click on a Storage Center and select Edit Settings.

2 Select Preferences.

3 Click Change.

4 Select the following:

Storage Type: Select the Storage Type to use as the default for new volumes.

Allow Storage Type selection: Select this option to allow the selection of a Storage 
Type when a volume is created.

5 Click Apply Changes.

Storage

 To set Storage Center cache options

Global cache settings overwrite cache settings for individual volumes. To enable caching 
for some volumes and not others, enable caching system-wide. Disable caching for 
individual volumes.

1 In the Navigation pane, right click on a Storage Center and select Edit Settings.

2 Select Storage.

3 Click Change.

4 Set cache options:

• Read Cache Enabled: Select this option to enable read cache.

• Write Cache Enabled: Select this option to enable write cache.

5 Click Apply Changes.

6 Click OK to close the window.
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 To schedule or limit Data Progression (For version 5.1 or above)

Data Progression leverages cost and performance differences between storage tiers, 
allowing the maximum use of lower-cost drives for stored data, while maintaining high-
performance drives for frequently-accessed data. Storage Center polls blocks to see if they 
have been accessed. Blocks of data are then migrated up or down depending on use. The 
amount of time the migration takes depends on the amount of data to be migrated.

1 In the Navigation pane, right click on a Storage Center and select Edit Settings.

2 Select Storage.

3 Click Change.

4 Under the Storage Center Data Progression Settings, click in the Run Everyday at 
field. Select or enter a time as hh:mm AM or PM.

5 In the Maximum Run Time field, set the maximum time for Data Progression to run.

6 Click Apply Changes.

7 Click OK to close the window.

 To set stripe width

The default stripe width for storage profiles is 10 wide (RAID 6-10). Modifying this value 
updates the RAID 6 selections for all system Storage Profiles. It also modifies the RAID 6 
selections for user created Storage Profiles unless Manual Storage Mode is enabled for the 
system. 

In a standard Storage Center system, a percentage of most-used data is storage on 
RAID 10 (striped and mirrored). Data that is used less is stored on RAID 6-10 (which uses 
an algorithm to rebuild data if one drive in the logical unit should fail). For RAID 5, the stripe 
width determines whether the logical unit is comprised of five or nine drives. For RAID 6, 
the stripe width determines whether the logical unit is comprised of six or ten drives. 
Distributing data across more drives is marginally more efficient, but increases vulnerability. 
Distributing data across fewer drives is less efficient, but marginally decreases vulnerability.

1 In the Navigation pane, right click on a Storage Center and select Edit Settings.

2 Select Storage.

3 Click Change.

• RAID 5 Stripe Width: Select a stripe width of either 5 disks or 9 disks.

• RAID 6 Stripe Width: Select a stripe width of either 6 disks or 10 disks. 

4 Click Apply Changes.

5 Click OK to close the window. 
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Data Collector

 To send Storage Center alerts and logs to the Data Collector
1 In the navigation pane, right-click on a Storage Center and select Edit Settings.

2 Click Data Collector to display Storage Center properties for the Data Collector.

3 Click Change to change the following:

Send Alerts to This Data Collector: Enable this option to send alerts from this Storage 
Center to the Data Collector to which you are currently connected.

Send Logs to This Data Collector: Enable this option to send logs from this Storage 
Center to the Data Collector to which you are currently connected.

4 Click Apply Changes.

5 Click OK to close the window. 
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 To forward Storage Center log messages to a syslog server

Enterprise Manager can forward logs received from Storage Centers to another syslog 
server. When you set up syslog forwarding, note the following:

• For pre-5.1 Storage Center versions, Enterprise Manager Data Collector overwrites the 
syslog server setting for Storage Centers connected to the Data Collector. If you want 
to use a syslog server and Enterprise Manager, you must set up syslog forwarding for 
each Storage Center within Enterprise Manager to direct the logs to the syslog server. 
For Storage Center versions 5.1 and above, Enterprise Manager Data Collector does 
not overwrite the system log server settings.

• On the Enterprise Manager Data Collector server, UDP port 514 must be open for 
syslog forwarding.

To forward Storage Center log messages to a syslog server:

1 Right-click on a Storage Center, and select Edit Settings. 

2 Click Data Collector to display Storage Center properties for the Data Collector.

3 Click Change to change settings.

To create a new Syslog Forward:

a Click New. The Create Syslog Forward dialog appears.

b Enter the following:

• Host Name: Enter the host name or IP address of your syslog server.

• Facility: Select a facility.
c Click OK.
d Click Apply Changes.

To test a Syslog Forward:

• Select a Syslog Forward to test, and click Test.

View the syslog server to make sure the message was successfully forwarded to the 
server.

To delete a Syslog Forward:

a Select a Syslog Forward to delete, and click Delete.

4 Click Apply Changes.

5 Click OK to close the window. 
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Phone Home
For information on setting up and using phone home, see Phone Home on page 18.

Automated Reports
For information on setting up and using automated reports, see Reports Viewer on page 91.



30 Enterprise Manager 5.5 User Guide

Opening Storage Center Manager
From Enterprise Manager, you can go directly to the Storage Center Manager.

 To go directly to Storage Center Manager
1 Select a Storage Center.

2 Click the Storage Center Manager button in the upper right corner. The system opens 
the System Manager for that Storage Center in a new window. 
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Using Common Report Options
Reports display data from selected Storage Center systems.

 To save a report to a file
1 When the report is displayed, click Save. The Export Report dialog appears.

2 Select a file type for the output - CSV (.csv), Text (.txt), Excel (.xls), HTML (.htm), XML 
(.xml), and PDF (.pdf).

3 Browse to a directory in which to save the exported file. Enter a filename.

4 Click OK.

 To search for an item in a report

Use the Search Toolbar to locate items in the report display.

 To filter report results
1 When the report is displayed, click Filter. The Filter dialog appears.

2 Select filter options:

• Show Last: Shows only the specified last number of days.

• Start Date: Specifies a start date for the results.

• End Date: Specifies an end date for the results.

• Subsystem: Specifies the subsystem by which to filter results.

• >= Log Level: Specifies a greater than or equal level by which to filter results.

3 Click OK.

 To update data displayed in a report
1 Click Update.

2 Select the start and end time for the data, and click OK.

 To set update frequency for a report or display

Some displays allow you to set the frequency for automatically updating displayed data. To 
set the frequency by which data is updated in a display:

1 Click Set Update Frequency. 

2 Select the frequency at which to update the display: Off (no automatic update), 
1 minute, 5 minutes, or 10 minutes.
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Introduction
Enterprise Manager displays information for a selected Storage Center or for multiple 
Storage Centers. 

• Single-Storage Center displays are called Views.

• Multi-System displays and functions are called Viewers.

The following table shows the single Storage Center views and multi-system viewers.

Single-System Views Multi-System Viewers

System>View>System Summary

See Storage Center Summary on page 36

See Multi-System Summary Viewer on page 42

System>View>Current Alerts

See Current Alerts on page 44

See Current Alerts Viewer on page 45

System>View>Historical Alerts

See Historical Alerts on page 46

n/a

System>View>Log Viewer

See Log Viewer on page 47

n/a

System>View>IO Usage

See Working with the IO Usage Report on 
page 97

n/a

System>View>Storage Management

See Storage Center Tasks on page 51

n/a

System>View>Replication Validation

See Managing Replications on page 101

See Managing Replications on page 101

System>View>Charting

See Charting Viewer on page 125

n/a

n/a

See Reports Viewer on page 91
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n/a

See Using Chargeback on page 137

n/a

See Using Threshold Alerts on page 155

n/a

See Using the Servers Viewer on page 165

n/a

See Remote Data Collector on page 203.

Single-System Views Multi-System Viewers
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Storage Center Summary
The Storage Center Summary is the default view. The view can include the following 
summary reports:

• Storage Center Status

• Storage Summary

• Front End IO Summary

• Current Alerts

• Replication Validation

• Top 10 Fastest Growing Volumes

• Current Threshold Alerts

 To select the summaries to include

1 When the Storage Center Summary report is displayed, click . The 
Storage Summary View dialog appears.

2 Select the reports to include in the display:

• Storage Center Status: Shows current status for a Storage Center.

• Storage Summary: Shows summary reports for storage savings. 

• Storage History: Shows summary reports for historical storage usage.

• Front End IO Summary: Shows summary reports for front end (FE) kilobyte per 
second read/write and IO per second.

• Current Alerts: Shows summary report for current alerts.
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• Replication Validation: Shows summary report for replications.

• Top 10 Fastest Growing Volumes: Shows summary report for top 10 fastest 
growing volumes.

• Current Threshold Alerts: Shows all Storage Center objects for which thresholds 
have been reached.

3 Use the up and down arrows to position the reports within the display.

4 Click OK to close the dialog.
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Storage Center Status

The Storage Center Status Summary gives an at-a-glance summary of Storage Center 
resource usage, as well as a summary of alerts.

• Storage Threshold

• FE IO Threshold

• FE KB Threshold

• Current Alerts

• Threshold Alerts

To go to the details page for a given status, click on the status indicator. For example, to go 
to the Storage Management display, click on the Storage Threshold indicator. The following 
table describes the status indicators.

Status 
Indicator

Description

Indicates the resource is currently well below its usage threshold.

Indicates the resource is close to reaching its usage threshold.

Indicates the resource has exceeded its usage threshold and an alert has been 
issued.

Indicates the resource has no defined threshold.
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Storage Summary

Storage Summary displays two summary charts: 

• Storage Savings: Bar chart that shows Configured Volume Space, Active Space, 
Replay Space, Savings vs. RAID 10, Total Disk Space, Allocated Space, Used Disk 
Space, and Free Disk Space.

• Historical Storage Usage: Graph comparing Total Disk Space, Allocated Space, Used 
Space, and Active Space. Also reports the Used Space Growth Rate and an Estimated 
System Full Time (if possible).
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Front End IO Summary

Front End IO Summary displays front end IO from the servers for the last two weeks in 
KB/sec and IO/sec. Graph lines represent:

• Front End Read

• Front End Write

• Front End Total

Current Alerts

Current Alerts shows all objects that are currently alerting the Storage Center. (Current 
Alerts reports information only from Storage Center version 3.6 or above.)

Replication Validation

Replication Validation displays a list of replications and corresponding statuses.
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Top 10 Fastest Growing Volumes

Displays the top ten fastest growing volumes based on overall storage usage:

• Configured size: Displays the virtual size of the volume.

• Active: Lists Actual Size, Growth Rate, the percentage of the Actual Size compared to 
the Configured Size amount of space, and, based on the rate of growth, when the Actual 
Size will equal the Configured Size.

• Replay: Displays the amount of storage space on a volume that is taken up by Replays, 
and the growth rate over the last defined period. 

• Actual Size: Displays the average amount of storage space taken up per day by data 
with Replays, but without RAID overhead. Growth rate is the actual growth over the last 
defined period.

• Last Updated: Displays the date and time the data in this Summary was last updated.

Current Threshold Alerts

Displays all current threshold alerts for the Storage Center. See Using Threshold Alerts on 
page 155 for information on setting up threshold alerts.
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Multi-System Summary Viewer
The Multi-System Viewer displays data for all Storage Centers managed by the Enterprise 
Manager. To view multi-system data, in the list of Viewers, click Multi-System. The Multi-
System View compares overall Storage Center storage and the number of objects on each 
Storage Center. 

Table View
The default view for Multi-System is a table view of all Storage Centers monitored by the 
Client. Tabs at the top of the window display a Multi-System Storage Chart and a Multi-
Storage Center Object Chart.

All Storage Centers

For all Storage Centers, the top frame displays a table that lists aggregate data for all 
systems, followed by a list of systems monitored by Enterprise Manager.

• Name: All Systems or name of individual system.

• Configured: Total size for all volumes present to servers.

• Oversubscribed: Configured space minus the total available space.

• Available: Amount of disk space available on all drives on the system.

• Allocated: Amount of disk space allocated to all the disks on the system (in MB, GB, or 
TB).

• Used: Amount of space written to by servers or consumed in Replays.

• Replay: Amount of space used by Replays.

• Savings: Amount of space saved by effective use of RAID 5.

• Controllers: Number of controllers on the System.

• Servers: Number of servers on the System.

• Volumes: Number of volumes on the System.

• Replays: Number of Replays on the volumes of the System.

• Disks: Number of disks attached to the system on the System.

• Managed: Number of managed disks (does not include spare disks) on the Storage 
Center.

• External: Number of disks attached as External devices.

• Replications: Number of volumes being actively Replicated from this system.

In the bottom frame, use the pull-down menu at the right of the pane to select the Storage 
Center view you want to display for all systems:

• Storage Center Status

• Storage History

• Storage Summary

• Front IO Summary

• Current Alerts
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• Replication Validation

• Top 10 Fastest Growing Volumes

• Current Threshold Alerts

By default, Storage Center Status is displayed for all Storage Centers.

Storage Chart
To view a Multi-System storage chart, in the Multi-System viewer window, click the 
Storage Chart tab. Enterprise Manager displays a bar chart showing the amount of storage 
available and consumed by each system. 

Object Chart
To view a Multi-System object chart, in the Multi-System viewer window, click the Object 
Chart tab. Enterprise Manager displays a bar chart showing the number of controllers, 
servers, volumes, disks, and replications in bar chart format.
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Current Alerts

 To view current alerts for one Storage Center
1 Right-click on a Storage Center.

2 From the shortcut menu, select View > Current Alerts. The Current Alerts window 
appears. 

 To acknowledge an alert

• On the Current Alerts view or viewer, right-click on the Storage Center alert you want 
to acknowledge, and click Acknowledge.
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Current Alerts Viewer
The Current Alerts Viewer displays a summary of all current alerts for all Storage Center.

 To view current alerts for all Storage Centers

• In Viewers pane, click Current Alerts.

 To acknowledge an alert

• On the Current Alerts view or viewer, right-click on the Storage Center alert you want 
to acknowledge, and click Acknowledge.

Current Alerts Information
• Storage Center: Name of the Storage Center that generated the alert.

• Object Name: Name of component. Go to the Storage Center Manager for more 
information about the object.

• Date/Time: Date and time alert was recorded.

• Message: Detailed alert message.

• Status: Current status of the alert.

• Definition: Alert definition.
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Historical Alerts
To view historical alerts:

1 Right-click on a Storage Center.

2 Select View > Historical Alerts. The Historical Alerts view appears.

Note Historical Alerts displays a maximum of 500 messages. 
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Log Viewer
To view the logs:

1 In the Storage Centers frame, right-click on a Storage Center.

2 From the short-cut menu, select View > Log Viewer. The Log viewer appears.

Note Logging displays a maximum of 500 messages.
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Remote Data Collector
The Remote Data Collector Viewer displays connection information for the Remote Data 
Collector. 
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The top panel shows information on the Remote Data Collector connection and provides 
DR options.

Subsequent panels display Primary/Remote Data Collector information for each Storage 
Center in the Enterprise Manager client, and information on replicating volumes.

Field/Option Description

IP Address Shows the IP address of the Remote Data Collector.

State Shows the current state of the Remote Data Collector: Connected or 
Not Connected.

Last Connection Shows the date and time when the Remote Data Collector last 
connected to the Primary Data Collector.

Last Sync Shows the date and time when the remote and primary Data 
Collectors last synchronized data.

DR Options

Test Activate DR Site Tests the activate DR site routine and returns results. See Preparing 
for Disaster Recovery on page 196 for information on testing 
activation of a DR site.

Activate DR Site Activates a DR site. See Activating Disaster Recovery on page 198 
for information on activating a DR site.

Validate Restore Points Validates restore points. See Saving and Validating Replication 
Restore Points on page 110 for information on validating restore 
points.

Field/Option Description

Version Shows the Storage Center version running on the Storage Center.

Primary Host Shows the name or IP address of the primary Storage Center.

Remote Host Shows the name or IP address of the remote Storage Center.

Primary IP Address Shows the IP address of the primary Storage Center.

Remote IP Address Shows the IP address of the Remote Storage Center.

Primary State Shows Connected or Not Connected.

Remote State Shows Connected or Not Connected.

Replicating Volumes

Source Volume Shows the name of the source volume.

Source Storage Center Shows the Storage Center for the source volume.

Destination Storage Center Shows the destination Storage Center.

State Shows the state of the replication: Good or Warning.

Status/Reason Provides an explanation of the state.

Validate Restore Points Validates restore points. See Saving and Validating Replication 
Restore Points on page 110 for information on validating restore 
points.
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For information on installing and connecting a remote Data Collector, refer to the Enterprise 
Manager Installation and Setup Guide. For information on connecting a client to the remote 
Data Collector, see Remote Data Collector on page 203.
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Introduction
The Storage Management view allows you to view and manage storage on the selected 
Storage Center. The view displays a navigation pane similar to the Storage Center Manager 
navigation pane and a display pane.

Opening the Storage Management View
1 In the Storage Centers frame, right-click on a Storage Center for which you want a 

report. 

2 From the short-cut menu, select View > Storage Management. 

The Storage Center and components tree is displayed in the left pane of the report. The 
right pane displays information for the selected component. 
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Navigation Pane
The Storage Management navigation pane shows the following nodes:

• Storage Center: Shows a summary of current and historical storage usage on the 
selected Storage Center.

• Volumes: Allows you to create and manage volumes and volume folders, as well as 
create a local recovery from a volume Replay. For information on creating and 
managing volumes, see Managing Volumes on page 55.

• Servers: Allows you to create and manage physical and virtual servers, server clusters, 
and server folders. For information on creating and managing servers, see Managing 
Servers on page 62.

• Remote Storage Centers: Allows you to create and view iSCSI connections to remote 
Storage Centers for which you have access. For information on creating iSCSI 
connections, see Configuring iSCSI Connections on page 105.

• Disks: Allows you to view disk folders on the Storage Center. For information on 
Storage Center disk folders, refer to the Storage Center System Manager User Guide.

• Portable Volumes: Allows you to view and manage portable volumes. For information 
on creating and managing portable volumes, see Working with Portable Volumes on 
page 79.

• Storage Types: Allows you to view the Storage Types prepared on the Storage Center. 
For information on Storage Types, refer to the Storage Center System Manager User 
Guide.

• Replay Profiles: Allows you to view, modify, and create Replay profiles for the Storage 
Center, as well as apply Replay Profiles to one or more volumes. For complete 
information on Replay Profiles, refer to the Storage Center System Manager User 
Guide.

• Storage Profiles: Allows you to view Storage profiles defined on the Storage Center. If 
the logon user account for the Storage Center permits modifying Storage Profiles, 
allows creating and modifying Storage Profiles. For complete information on Storage 
Profiles, refer to the Storage Center System Manager User Guide.

Display Pane
The right side of the display shows one or more display tabs with information for the node 
or object selected in the navigation pane. 
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Setting Storage Management Properties
Use the Storage Panel Properties dialog to specify warning and error thresholds to display 
for Storage Objects, Volume Objects, and Server Objects in the Storage Management 
display. In addition, you can select the unit format (Automatic, MB, GB, or TB) for the 
displays.

To select the warning and error thresholds

1 Click the Properties button at the top right of the Storage Management display. The 
Storage Panel Properties dialog appears.

2 Enter the warning and error threshold markers to display for Storage, Volume, and 
Server objects. Storage objects include disks, disk classes and disk tiers; volume 
objects include volumes and volume folders; server objects include servers and 
server folders.

3 Select the unit formats for the displays: Automatic, MB, GB, or TB.

4 Click OK.
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Managing Volumes
A volume is logical storage repository. Volumes can be created only from an assigned 
folder of managed disks. Note that you can allocate more logical space to a volume than is 
physically available. It is crucial that you monitor system alerts so that you know when you 
need to add more physical space to a Storage Center. 

Volume Attributes
When you create a volume, you are prompted to specify attributes for the volume. The 
following descriptions list all available volume attributes.

Allocation Size
For volumes mapped to Server Agents only. Select the amount of space to allocate to 
the volume. Default is to allocate the volume size.

Controller
For a dual-controller Storage Center, select the controller for mapping the volume.

Create as Live Volume
If you enable the Create as Live Volume option, Enterprise Manager displays the 
Convert to Live Volume Wizard. See Creating and Managing Live Volumes on page 76 
for details on creating a Live Volume.

Enforce Volume Space Consumption Limit
Allows you to enforce a specified volume space consumption limit.

Format Volume on Server
For volumes mapped to Server Agents only. To format and mount the volume, enable 
Format Volume and then select either a drive or folder to which to mount the volume on 
the server.

Import to Lowest Tier
Allows you to force all data written to the volume to the lowest storage tier configured 
for the volume. By default, this option is disabled and data is written to the highest 
storage tier configured for the volume per the Storage Profile attached to the volume. 
This option is available only via the Edit Settings options for the volume; this option is 
not available during volume creation.

Name
Enter a name for the volume.

Parent Folder
Click Change and select a parent folder for the volume.

Pause Replay Creation
Pauses Replay creation for the volume.

Pause Replay Expiration
Pauses both Replay creation and expiration for the volume.
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Read Cache Enabled
Enables read cache for the volume.

Replay Profiles
Click Change and select the Replay Profiles to apply to the volume. 

Replicate Volume to Another Storage Center
If you enable the Replicate Volume to Another Storage Center option, Enterprise 
Manager displays the Create Replication wizard. See Creating Replications on 
page 109 for details on creating a replication. When you have finished, continue with the 
Create Volume dialog.

Server
Click Change to select or change the server to which you want to map the volume. Click 
Advanced Mapping to select paths and LUNs for the mapping. Note if you are creating 
a volume via the Servers Viewer, you cannot change the server.

Size
Enter the volume size in GB (gigabytes) or TB (terabytes).

Storage Profile
Select the Storage Profile for the volume. 

Storage Type
Select the type of storage for the volume. Options available are dependent on the 
storage types available on the Storage Center. 

Windows Format Type
For volumes mapped to Server Agents only. Select the Microsoft Windows format type 
MBR or GPT.

Windows Volume Label
For volumes mapped to Server Agents only. Enter text to use as the Windows volume 
label.

Write Cache Enabled
Enables write cache for the volume.

Mapping Attributes—General

Server
Server (physical or virtual) or server cluster to which to map a volume.

Volume
Volume to be mapped to a server.

Mapping Attributes—Advanced

Use Next Available LUN
Enable this option to allow the Storage Center to use the next available LUN to map the 
volume.
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LUN to use when mapping to Volume
Specifies a LUN to use to map the volume.

Use the next available LUN if specified LUN is unavailable
Enable this option to allow the Storage Center to use the next available LUN to map the 
volume if the specified LUN is not available.

Volume used as Boot Volume
Enable this option to map a volume as a boot volume.

Maximum number of paths per server
For multi-pathed servers, specify a limit for the number of paths to use for mapping the 
volume.

Allow the Storage Center to automatically determine best controller for activating the 
volume

For dual-controller Storage Centers. Enable this option to allow the Storage Center to 
determine the controller on which to activate the volume.

Volume presented to server as read-only
Enable this option to map a volume as read only.

Creating One or More Volumes
Use the Create Volume or Create Multiple Volumes dialogs to create, map, mount, and 
replicate a volume to another Storage Center in one step.

1 Select a Storage Center in which to create volumes.

2 From the Storage Center Tasks menu, select Volumes > Create Volume or Create 
Multiple Volumes.

3 Enter information for the volume(s). For information on volume options, see Volume 
Attributes on page 55. For information on mapping options, see Mapping Attributes—
General on page 56 and Mapping Attributes—Advanced on page 56.

4 When you have finished specifying options for the volume, click OK to create the 
volume.

Editing a Volume
You can change the name, parent folder, import option, or Replay profile for a volume using 
the Edit Settings options. See Volume Attributes on page 55 for information on volume 
attributes. To change mappings for a volume, see Removing Server Mappings on page 65 
or Mapping a Server to a Volume on page 64.

1 In the navigation pane of Storage Management display, right-click a volume.

2 Select Edit Settings.

3 Change settings for the volume, and click OK.
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Expanding a Volume
1 In the navigation pane of the Storage Management display, right-click on the volume 

you want to expand. 

2 Select Expand Volume.

3 Enter a new size for the volume.

4 Click OK.

Deleting a Volume
1 In the navigation pane of either the Storage Management display or the Servers 

Viewer, right-click on the volume you want to delete, and select Delete. The Delete 
Volumes window appears. 

Note By default, a deleted volume is moved to the Recycle Bin. You can recover the 
volume from the Recycle Bin, but once the Recycle Bin is emptied, data on that 
volume cannot be recovered.

2 (Optional - and not recommended) You can immediately delete the volume and not save 
the metadata in the Recycle Bin by checking Purge Volume (Delete from Recycle 
Bin).

3 Click OK to delete the volume. The volume is marked for deletion and moved to the 
Recycle Bin. 
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Creating a Volume Folder

Note Create volume folders either to organize volumes or to restrict access to volumes. 
For more information on restricting access to users and groups, refer to the Storage 
Center System Manager User Guide. 

1 In the Storage Center Tasks menu, select Volumes > Create Volume Folder. The 
Create Volume Folder dialog appears.

2 Enter the following:

Name: Enter a name for the volume folder.

Notes: Optionally enter notes for the volume folder.

Parent Folder: Click Change to select the parent for the new folder.

3 Click OK.

Modifying a Volume Folder
1 In the navigation pane of the Storage Management display, right-click on an empty 

volume folder and select Edit Settings.

2 Change any of the following:

Name: Enter a new name for the volume folder.

Notes: Optionally enter notes for the volume folder.

Parent Folder: Click Change to change the parent folder of the folder.

3 Click OK.

Deleting a Volume Folder

Note Only empty volume folders can be deleted.

1 In the navigation pane of the Storage Management display, right-click on an empty 
volume folder and select Delete.

2 Click OK to delete the folder.

Creating a Replay for a Volume
1 In the navigation pane of the Storage Management display, right-click on the volume 

for which you want to create a Replay and select Create Replay. The Create Replay 
dialog appears.

2 Enter the following:

Expiration: Enter the number of minutes, hours, days, or weeks at which you want to 
expire the Replay. If you do not want to expire the Replay, enable Never Expire.
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Description: Enter a description of the Replay. The default descriptive text is “Manually 
Created.”

3 Click OK.

Creating a Boot from SAN Copy
1 In the navigation pane of the Storage Management display, right-click on the volume 

for which you want to create a boot from SAN copy, and select Create Boot from SAN 
Copy.

2 Enter information for the boot from SAN copy. For information on volume options, see 
Volume Attributes.

3 Click OK to create the boot from SAN copy.

Creating Replay from a Replay Profile
1 In the navigation pane of the Storage Management display, right-click on a Replay 

profile and select Create Replay.

2 Enter the following:

Expiration: Enter the number of minutes, hours, days, or weeks at which you want to 
expire the Replay. If you do not want to expire the Replay, enable Never Expire.

Description: Enter a description of the Replay. The default descriptive text is “Manually 
Created.”

3 Click OK.

Applying a Replay Profile to a Volume
1 In the navigation pane of the Storage Management display, right-click on a Replay 

profile and select Apply to Volume(s).

2 Select one or more volumes to which you want to apply the Replay profile.

3 If you want to replace the existing Replay profiles for the volume(s), select Replace 
Existing Replay Profiles.

4 Click OK.

Applying a Replay Profile to all Volumes Mapped to a Server
1 In the navigation pane of the Storage Management display, right-click on a Replay 

profile and select Apply to Server.

2 Select the server to which you want to apply the Replay profile.

3 If you want to replace the existing Replay profiles for the volume(s), select Replace 
Existing Replay Profiles.

4 Click OK.



61 

Managing Volumes

Creating a Local recovery volume from a replay
1 In the navigation pane of the Storage Management display, click on the volume for 

which you want to use a Replay to create a local recovery volume. 

2 Click the Replays tab.

3 From the list of available Replays, right-click on the Replay from which you want to 
create a local recovery volume, and select Create Local Recovery. The Create Local 
Recovery dialog appears.

4 Enter information for recovery volume. For information on volume options, see Volume 
Attributes on page 55.

5 Click OK to create the local recovery volume.

Expiring a Replay
1 In the navigation pane of the Storage Management display, click on a volume. 

2 Click the Replays tab.

3 Select one or more Replays to expire, right-click, and select Expire Replay.

4 Click Yes to expire the selected Replays.
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Managing Servers
Enterprise Manager provides two views of Storage Center servers:

• Storage Management View
Shows all servers for the selected Storage Center. 

• Servers Viewer
Shows all registered servers for all Storage Centers.

You can manage servers via either of the displays. This section describes managing 
servers on the Storage Management View. For information on registering servers on the 
Servers viewer and gathering operating system information for the servers, see Using the 
Servers Viewer on page 165.

Server Attributes
When you create a server, you are prompted to specify attributes for the server. The 
following descriptions list all available server attributes.

Name
Enter a name for the server.

Notes
Optionally enter notes for the server.

Operating System
Select the operating system of the server. To see operating system characteristics for 
the selected operating system, click .

Parent Folder
Click Change to select the parent folder for the new server.

Select the Servers Host Bus Adapters
Select one or more host bus adapters (HBAs) for the server from the list of displayed 
HBAs or manually enter HBAs for the server.

Select Server to Add to Cluster
To add an existing server to the cluster, click Add Existing Server and select a server. 
To remove a server from the cluster, select the server and click Remove Selected. 

iSCSI Name
Check to display the iSCSI name. Uncheck to display the iSCSI IP Address. 

Note You can add an IP address for an HBA that will be installed on the server in the future 
and display the server under the iSCSI name. When the iSCSI HBA that uses that 
IP address is installed, it will be configured and ready to use. 
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Creating a Server Folder
1 In the navigation pane of the Storage Management display, right-click on the Servers 

icon and select Create Server Folder. The Create Server Folder dialog appears:

2 Enter the following:

Name: Enter a name for the folder.

Notes: Optionally, enter notes to describe the folder.

Parent Folder: Click Change to select a parent folder for the new folder.

3 Click OK to create the folder.

Modifying a Server Folder
1 In the navigation pane of the Storage Management display, right-click on the server 

folder you want to modify and select Edit Settings.

2 Modify any of the following:

Name: Enter a new name for the folder.

Notes: Optionally, enter notes to describe the folder.

Parent Folder: Click Change to select a parent folder for the new folder.

3 Click OK.

Deleting a Server Folder

Note You can delete only empty server folders. To move servers to another server folder, 
go to the Storage Center System Manager.

1 In the navigation pane of the Storage Management display, right-click on the server 
folder you want to delete and select Delete.

2 Click OK to delete the folder.

Creating a Physical Server
1 In the navigation pane of the Storage Management display, right-click on the Servers 

icon or a server folder and select Create Server. The Create Server dialog appears.

2 Enter information for the new server. For information on server options, see Server 
Attributes on page 62.

3 Click OK.
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Creating a Virtual Server
1 In the navigation pane of the Storage Management display, right-click on the physical 

server on which to create a virtual server, and select Create Virtual Server. The 
Create Virtual Server dialog appears.

2 Enter the information for the virtual server. For information on server options, see Server 
Attributes on page 62.

3 Click OK.

Creating a Server Cluster
The cluster server operation allows you to group servers into a server cluster. Once servers 
are grouped in a cluster, volumes mapped to individual servers in the cluster are mapped 
to all servers in the cluster.

Note All servers in a server cluster must be running the same operating system.

1 From the Storage Center Tasks menu, select Server > Create Server Cluster. The 
Create Server Cluster dialog appears.

2 Enter information for the server cluster. For information on server options, see Server 
Attributes on page 62.

3 Click OK.

Modifying a Server
1 In the navigation pane of the Storage Management display, right-click on the server 

you want to modify, and click Edit Settings. 

2 Edit the server settings, and click OK.

Mapping a Server to a Volume
1 In the navigation pane of the Storage Management display, right-click on the server or 

volume you want to map, and click Map Server to Volume. 

2 Select a volume to map to the server, and click Next.

3 To specify advanced mapping options, click Advanced Mapping. Specify Advanced 
Mapping options, and click Next.

4 Click OK to create the mapping.
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Removing Server Mappings
1 In the navigation pane of the Storage Management display, right-click on the server for 

which you want to remove volume mappings, and select Remove Mappings. 

2 Select the mappings to remove, and click OK.

3 a volume to map to the server, and click Next.

Adding HBAs to a Server
1 In the navigation pane of the Storage Management display, right-click the server for 

which you want to add an HBA. Select Add HBAs to Server. The Add HBAs to Server 
dialog appears.

2 From the list of available HBAs, select one or more host bus adapters (HBAs) to add to 
the server.

3 Check to display the iSCSI name (IQN). Uncheck to display the iSCSI IP Address. 

4 Click OK.

Manually Add HBA to Server
1 In the navigation pane of the Storage Management display, right-click the server for 

which you want to add an HBA. Select Add HBAs to Server. The Add HBAs to Server 
dialog appears.

2 Click Manually Add HBA. The Manually Add HBA to Server window appears.

3 Enter the name of an HBA.

4 Select a transport type: FC or iSCSI. 

5 Click Back. 

6 In the Add HBAs to Server dialog, click OK. 

Removing HBAs from a Server
1 In the navigation pane of the Storage Management display, right-click on the server 

from which to remove the HBA. Select Remove HBAs from Server. The Remove 
HBAs from Server dialog appears.

2 From the list of current server HBAs, select one or more host bus adapters (HBAs) to 
remove.

3 Click OK.
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Deleting a Server

Warning When you delete a server, all volume mappings to the server are also deleted.

1 In the navigation pane of the Storage Management display, right-click on the server 
you want to delete and select Delete. 

2 Click OK.

Applying a Replay Profile to a Server
1 In the navigation pane of the Storage Management display, right-click on the server for 

which you want to apply one or more Replay profiles, and select Apply Replay 
Profiles to Server. 

2 Select one or more Replay profiles to apply to server volumes.

3 If you want to replace the existing Replay profiles for the volume(s), select Replace 
Existing Replay Profiles.

4 Click OK.

Working with NAS and zNAS Servers
Enterprise Manager communicates with Dell Compellent NAS and zNAS servers via the IP 
address of the Intelligent Platform Management Interface (IPMI) card. In Enterprise 
Manager 5.3:

• The Microsoft-based NAS server ships with Generation 2 hardware

• The Open-Source-based zNAS server ships with Generation 3 hardware. 

For information on setting up and using a Dell Compellent NAS server, refer to:

• Storage Center NAS Setup Guide

• Storage Center NAS User Guide. 

For information on setting up and using a Dell Compellent zNAS server, refer to:

• Storage Center zNAS Setup Guide

• Storage Center zNAS User Guide

For information on configuring IPMI on the NAS and zNAS servers and configuring IPMI on 
Dell Compellent Hardware, refer to the Enterprise Manager 5 Installation and Setup Guide.
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Managing Replay Profiles

What are Replays and Replay Profiles?
A Replay is a point-in-time copy of one or more volumes. A Replay Profile is a collection of 
rules describing when to take periodic Replays for one or more volumes and the time at 
which Replays are deleted (expired). By default, Storage Center provides two standard 
Replay Profiles: Daily and Sample. These Replay Profiles cannot be modified or deleted.

Non-Consistent and Consistent Replays
A Consistent Replay Profile halts IO to all volumes to which the Replay Profile is attached 
until Replays are taken for each volume.

Consistent Replay Profile Non-Consistent Replay Profile

Halts IO across all volumes as a group Halts I/O for each volume independently of other 
volumes. 

Resource intensive Less resource intensive - depends on the amount 
of data written since the previous Replay

Limited to 40 volumes No limit to the number of volumes to which the 
Replay Profile is attached

Replays are taken of all volumes simultaneously Choose between Serial (one volume at a time) or 
Parallel (all volumes simultaneously)

Can set an Alert if Replays cannot be completed 
within a defined time. Replays not completed 
before alert is generated are not taken. (This 
can lead to incomplete groups of Replays 
across volumes.)

All Replays are taken

Can delete incomplete group of Replays All Replays are taken

Can be converted to Non-Consistent Replay 
Profile

Can be converted to Consistent Replay Profile
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Creating a Replay Profile
1 Right-click on a Storage Center and select Tasks>Replay Profile>Create Replay 

Profile. The Create Replay Profile window appears. 

2 Enter the following:

Name: Enter a name for the Replay Profile.

Notes: Optionally, enter notes for the profile.

Scheduled Rules: Add one or more rules to the profile.

Advanced Options: Select the Replay profile type: Serial, Parallel, or Consistent. For 
information on Replay Profile types, see Non-Consistent and Consistent Replays on 
page 67.

3 When you have finished defining the Replay Profile, click OK.
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Modifying a Replay Profile

Note Changes to a Replay Profile affect only new Replays taken with the modified Replay 
Profile. Existing Replays are not changed.

1 Right-click on a user-defined Replay Profile and select Edit Settings.

2 Edit the following:

Name: Enter a name for the Replay Profile.

Notes: Optionally, enter notes for the profile.

Scheduled Rules: Add, Edit, or Remove rules for the profile.

Advanced Options: Select the Replay profile type: Serial, Parallel, or Consistent. For 
information on Replay Profile types, see Non-Consistent and Consistent Replays on 
page 67.

3 When you have finished defining the Replay Profile, click OK.

Applying a Replay Profile to Volume(s)
1 Right-click on a Replay Profile and select Apply to Volume(s).

2 Select one or more volumes to which you want to apply the Replay Profile.

3 Click OK.

Applying a Replay Profile to Server(s)
1 Right-click on a Replay Profile and select Apply to Server(s).

2 Select one or more servers to which you want to apply the Replay Profile.

3 Click OK.

Deleting a Replay Profile
1 Click on the user-defined Replay Profile you want to delete.

2 Make sure the Replay Profile is not in use by any volumes.

3 Right-click on the Replay Profile you want to delete, and select Delete.

4 Click Yes.
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Modifying Replay Profile Expiration for Remote Replays
By default, Replay Profiles applied to remote volumes have the same rules for expiration 
as for local volumes. However, you can specify different expiration rules for remote volumes 
if needed. 

1 Click on the Replay Profile for which you want to modify expiration rules for remote 
Replays.

2 In the Rules tab of the display, right-click on the schedule and select Edit Remote 
Replay Expiration.

3 Do the following:

a Select the remote Storage Center for which you want to specify an expiration rule for 
the Replays.

b Enter a time for the Remote Expiration.
c Click OK.
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Managing Storage Profiles
Storage Profiles describe the RAID level and tiers on which data is stored. If disk space is 
not available within a selected tier, space in other tiers is used until space becomes 
available in the selected tier. All Storage Centers provide a set of standard Storage Profiles.

• Data can be migrated between RAID levels within a tier and between tiers. The system 
displays the Recommended Storage Profile to migrate data between tiers. The default 
Storage Profile for a system with Data Progression is the Recommended Storage Profile

• If Data Progression is not licensed and a system uses RAID 10 and RAID 5, data is 
migrated up or down with in a Tier (drive class) but cannot be migrated between Tiers. 

• If Data Progression is not licensed, a system has access only to Storage Profiles that 
use a single tier of storage; Storage Profiles with multiple tiers are not available. The 
default Storage Profile for a system without Data Progression is the High Priority 
Storage Profile.

By default, Storage Profiles are applied automatically and do not appear when you create 
a volume. To select a Storage Profile, your User Volume Defaults determine options for 
configuring volume defaults. Refer to the Storage Center System Manager User Guide for 
information on changing User Volume Defaults. 

Creating a Storage Profile

Note To create a Storage Profile, your Storage Center User Volume Default must allow you 
to create 

1 Select a Storage Center.

2 From the Storage Center Tasks menu, select Storage Profile > Create Storage 
Profile. The Create Storage Profile window appears. 

3 Enter the following:

Name: Enter a name for the storage profile.

RAID Level Used: Select the RAID levels for use by the storage profile.

Storage Tiers Used: Select one or more tiers for use by the storage profile.

Notes: Optionally, enter notes about the storage profile.

4 Click OK. 

Deleting a Storage Profile
1 In the Storage Management navigation pane, right-click a user-created storage profile.

2 Select Delete. The system asks you to confirm.

3 Click OK. 
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Exporting Objects
Exporting objects copies User, Server, Replay Profiles, and QoS Definitions from one 
Storage Center to another. 

 To export objects
1 Select a Storage Center, and select Tasks > Export Objects. The Import/Export 

Wizard appears.

2 Select a destination Storage Center for the exported objects, and click Next.

3 Select one or more objects to export: Users, Server Definitions, Replay Profiles, and 
QoS Definitions.

4 Click Next. The confirmation window appears.

5 Click Finish. The Export Results window appears, which lists the total number of objects 
exported. 

Note Only server objects visible on both the source and destination Storage Centers are 
exported.

6 Click OK.
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Introduction

Note In Storage Center 5.0 thru 5.1, Live Volume, a separately licensed Storage Center 
feature, is intended for evaluation/demonstration purposes only. Full functionality 
and support for Live Volume is provided in Storage Center 5.2 (and above).

Storage Center Live Volumes are a pair of replicating volumes: a source volume on a 
primary Storage Center that is replicating to a destination volume on a secondary Storage 
Center. Both volumes of the Live Volume replication pair can be active at the same time—
that is, the source volume on the primary Storage Center can be mapped and active on the 
primary Storage Center at the same time the destination volume on the secondary Storage 
Center is mapped and active on the secondary Storage Center.

The primary/secondary Storage Center roles that determine the direction of the replication 
can be swapped automatically or manually.

Note By default, data is replicated from the source volume on the primary Storage Center 
to the lowest storage tier configured for the destination volume on the secondary 
Storage Center. Use the Edit Live Volume Settings to change this default. See 
Editing Live Volume Settings on page 76.

Requirements
To create Live Volumes requires the following:

Live Volume Icons

Requirement Description

Enterprise Manager • Enterprise Manager 5.0 or above.

Storage Centers • Primary and secondary Storage Centers must be running 
Storage Center 5.0.2 or above.

• Primary and secondary Storage Centers must be licensed for 
Live Volume and Asynchronous Replications.

Connectivity • Enterprise Manager client must have access to the primary and 
secondary Storage Centers. That is, the Storage Centers must 
be added to the Enterprise Manager client.

• Primary and secondary Storage Centers must be connected to 
each other by FC connections.

Icon Description

Primary Live Volume—that is, the Live Volume that is currently 
replicating to the secondary Live Volume.

Secondary Live Volume—that is, the Live Volume to which the 
primary Live Volume is replicating.



75 

Introduction

Live Volume Roles and Role Swapping
By default, a new set of live volumes—a Primary Live Volume and a Secondary Live 
Volume—are set up to automatically swap roles. An automatic role swap of Live Volumes 
occurs when the following conditions are met:

• Minimum time as Primary Live Volume: A minimum amount of time as the primary 
Live Volume. The minimum amount of time is set by the Time as Primary before Swap 
attribute. See Replication, Live Volume, and Move Attributes on page 103.

• Minumum Storage Space Written to Secondary Live Volume: A minumum amount 
of storage space is written on the Secondary Live Volume. The minimum amount is set 
by the Min Amount for Swap attribute, which specifies the minimum storage space in 
KB. See Replication, Live Volume, and Move Attributes on page 103.

• Minimum Percentage of IO on Secondary Live Volume: A minimum percentage of 
IO takes place on the Secondary Live Volume. The minimum IO on the Secondary Live 
Volume is set by the Min Secondary % Usage for Swap attribute. See Replication, Live 
Volume, and Move Attributes on page 103.
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Creating and Managing Live Volumes
This section gives step-by-step instructions for creating and managing Live Volumes. For 
information on creating and managing standard Storage Center volumes, see Managing 
Volumes on page 55.

Creating a Live Volume
1 Right-click on a Storage Center, and select Tasks > Replication > Create Live 

Volume.

2 Select the secondary Storage Center, and click Next.

3 Select the volumes to replicate, and click Next.

4 Specify all replication, destination, and Live Volume options. For information on options, 
see Replication, Live Volume, and Move Attributes on page 103.

5 Click Next.

6 To start replicating the volumes, click Start. Enterprise Manager starts the replication, 
and the Replication Results window appears. 

7 Click Next. The Replication wizard asks if you want to save the restore points. Dell 
Compellent recommends saving the restore points.

8 Click on Save Replication Restore State. The Save Replication Recover State Wizard 
appears. See Saving and Validating Replication Restore Points on page 110.

Editing Live Volume Settings
1 Go to the Storage Management view of the Storage Center for which you want to 

change mappings of a Live Volume.

2 Right-click on the Live Volume you want to change, and click Edit Settings.

3 Edit the volume Name, Parent Folder, or Replay Profile(s).

4 Click OK.

Modifying Live Volume Replication Settings
1 Go to the Replications viewer.

2 In the Replications tab, right-click on a Live Volume replication and select Edit 
Settings.

3 Edit the Live Volume settings, and click OK. See Replication, Live Volume, and Move 
Attributes on page 103 for details on Live Volume settings.



77 

Creating and Managing Live Volumes

Swapping Live Volume Roles
1 Go to the Replications viewer.

2 In the Replications tab, right-click on a Live Volume replication and select Swap 
Primary Storage Center of Live Volume. A summary of screen appears.

3 Click OK to swap the primary Storage Center with the secondary Storage Center.

Canceling a Swap Primary Operation
1 Go to the Replications viewer.

2 In the Replications tab, right-click on a Live Volume replication that is currently 
swapping roles and select Cancel Swap Roles.

3 Click OK to cancel the swap roles operation.

Removing Live Volume Settings
1 Go to the Replications viewer.

2 In the Replications tab, right-click on the Live Volume replication for which you want 
to remove Live Volume settings and select Remove Live Volume Settings.

3 Click OK to remove the settings.

Converting a Replication to Live Volumes
1 Go to the Replications viewer.

2 In the Replications tab, right-click on the replication you want to convert to a Live 
Volume replication and select Convert to Live Volume.

3 Enter Live Volume settings, and click OK. For details on Live Volume settings, see 
Replication, Live Volume, and Move Attributes on page 103.

Converting a Volume to a Live Volume
1 Go to the Storage Management view of the Storage Center volume you want to 

convert.

2 Right-click on the volume, and select Convert to Live Volume. The Convert to Live 
Volume wizard appears.

3 Select the destination Storage Center for the Live Volume replication, and click Next.

4 Enter settings for the Live Volume replication. For information on options, see 
Replication, Live Volume, and Move Attributes on page 103.

5 Click OK.
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Monitoring Live Volume Replication
1 Go to the Replication viewer.

2 In the Replications tab, click on the Live Volume for which you want to monitor the 
replication.

For detailed information on viewing replications, see Using the Replication Viewer on 
page 119.
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Introduction
Portable volumes allow a site to replicate volumes from a source Storage Center to a 
destination Storage Center using removable USB disks. Portable volumes are set up and 
managed via the Enterprise Manager Storage Management display.

The general process of using portable volumes includes:

1 Starting a baseline replication from one or more source volumes on one Storage 
Center to another Storage Center on a USB disk.

2 When the replication completes, bring the USB disks to the destination site and restore 
the data to the destination Storage Center.

3 After the restore is complete, the source and destination volumes are synchronized.

Requirements

Portable Volumes Nodes

Requirement Description

Enterprise Manager • Enterprise Manager 5.0 and above.

Storage Centers • Source and destination Storage Centers must be running 
Storage Center 5.0.1 or above.

• Source and destination Storage Centers must be licensed for 
asynchronous replication.

Connectivity • Source and destination Storage Centers must be visible to 
Enterprise Manager.

• Source Storage Center must have the destination Storage Center 
set up as a Remote Storage Center; Destination Storage Center 
must have the source Storage Center set up as a Remote 
Storage Center. In addition, the source and destination Storage 
Centers must be visible to each other.

Removable Media Dell Compellent USB disks.

Portable Volume Node Description

Unassigned Shows USB disks on the Storage Center that are currently 
unassigned.

Repl Baseline To [dest] Shows USB disks on the Storage Center that contain baseline 
replications for which the Storage Center is the source.

Repl Baseline From 
[source]

Shows USB disks on the Storage Center that contain baseline 
replications for which the Storage Center is the destination.

Invalid
Shows USB disks on the Storage Center that contain replications for 
which the Storage Center is neither the source or destination of the 
replications.

Being Erased Shows USB disks on the Storage Center that are currently being 
erased.
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Portable Volume and Erase Portable Volume Attributes

1 Pass Full
Erase Portable Volume option: Performs one write pass on the disk and overwrites all 
data with zeroes.

7 Pass Secure Erase
Erase Portable Volume option: Performs seven write passes on the disk, first overwriting 
the data with zeroes and then overwriting the disk six more times with sequences of 
data.The secure erase requires significant time to complete.

Encryption Type
If encryption is selected, the encryption type is AES (Advanced Encryption Standard).

Security Key
If Use Encryption is enabled, enter text to use as a security key. A security key ensures 
that the encryption key is not sent as plain data between the two Storage Centers. A 
security key can up to 128 characters in length.

Select Portable Volumes
Select one or more USB disks from the list of available disks.

Quick Erase
Erase Portable Volume option: Erases the directory for the data.

Use Encryption
Enable this option if you want to encrypt data on the USB disk.
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Managing Portable Volumes
Before starting a replication to a portable volume, verify the following:

• Source and destination Storage Centers are at version 5.0.1 or above.

• Source and destination Storage Centers are visible (added) to the Enterprise Manager 
client.

• Destination Storage Center is defined as a remote Storage Center on the source 
Storage Center. If not, configure an iSCSI connection for the destination Storage Center. 
See Configuring iSCSI Connections on page 105 for details.

• USB disk is plugged into an available USB port on the source Storage Center.

Starting a Replication Baseline to a Portable Volume
1 Right-click on the source Storage Center, and select View >Storage Management. 

The Portable Volumes node appears in the navigation pane with an Unassigned 
node.

Note The Portable Volumes node displays only when there are one or more Dell 
Compellent USB disks present on the Storage Center.

2 Right-click on the Portable Volumes node and select Start Replication Baseline.

3 Select the destination Storage Center and click Next.

4 Specify portable volume attributes and disks. For information on portable volume 
attributes, see Portable Volume and Erase Portable Volume Attributes on page 81.

5 Click Next. 

6 Select volumes to replicate and click Add Volumes. Each time you add a volume, the 
Estimated Space Used by Volumes is updated. 
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7 When you have finished adding volumes, click Next. 

8 Specify replication options. For information on replication options, see Replication, Live 
Volume, and Move Attributes on page 103.

9 Click Next. The Replicate Volume(s) with Attributes window appears. 

10 If you want to change replication settings for a volume:

a Select the volume.
b Click Edit Selected.
c Select new options for the volume and click OK.

11 To start replicating the volumes, click Start. The Replication Results window appears.

12 Click Finish.

On the source Storage Center, Enterprise Manager creates a Portable Volume node for 
the replication to the destination Storage Center. For example:

On the destination Storage Center, Enterprise Manager creates a Portable Volume node 
for the replication from the source Storage Center. For example:

Adding a Disk to Replication Baseline
After you have created an initial replication baseline to a destination Storage Center, you 
can add more removable disks to the replication on which to write the replication.

1 Go to the Storage Management display for the source Storage Center.

2 In the Portable Volumes node, right-click on the Repl of Baseline To [dest] node, and 
select Add Portable Volumes.

3 Select an available portable volume, and click Finish.
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Adding a Volume to a Portable Volume
After you have created an initial basline replication to a destination Storage Center, you can 
add volumes to include in the replication.

1 Go to the Storage Management display for the source Storage Center.

2 In the Portable Volumes node, right-click on the Repl Baseline To [dest] node for the 
replication to which you want to add volumes, and select Add Volumes.

3 Select volumes to replicate and click Add Volumes. Each time you add a volume, the 
Estimated Space Used by Volumes is updated. 

4 Click Next. The Replicate Volume(s) with Attributes window appears. 

5 If you want to change replication settings for a volume:

a Select the volume.
b Click Edit Selected.
c Select new options for the volume and click OK.

6 To start replicating the volumes, click Start. The Replication Results window appears.

7 Click Finish. 

Modifying a Portable Volume Schedule
The Portable Volume Schedule allows you to define when portable volume copy and 
restore operations are allowed, as well the priority (Not Allowed/Low/Medium/High) for the 
operations. By default, the Portable Volume Schedule does not restrict portable volume 
copy/restore operations. To set up a schedule for portable volume operations:

1 Go to the Storage Management display for the source Storage Center.

2 Right-click on the Portable Volumes node, and select Edit Portable Volume 
Schedule.
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3 Use the mouse to select time slots on the grid and right-click to select a setting for the 
selected slots: Not Allowed, Low, Medium, or High.

4 Click OK when you have finished modifying the schedule.

Editing an Encryption Security Key
1 Go to the Storage Management display for the source Storage Center.

2 In the Portable Volumes node, right-click on the Repl Baseline to [dest] for which you 
want to change the security key.

3 Enter a new security key, and click OK.

Changing the Name of a Portable Volume
1 Go to the Storage Management display for the source Storage Center.

2 In the Portable Volumes node, open the Repl Baseline To [dest] node, right-click on 
the portable volume you want to change and select Edit Settings.

3 Enter a new name for the portable volume, and click OK.
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Erasing a Portable Volume
1 Go to the Storage Management display for the source Storage Center.

2 In the Portable Volumes node, right-click on the portable volume in the Unassigned 
folder you want to erase and select Erase.

3 Select the type of erase. For information on options for erasing portable volumes, 
seePortable Volume and Erase Portable Volume Attributes on page 81.

4 Click OK.
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Canceling a Portable Volume Replication
1 Go to the Storage Management display for the source Storage Center.

2 In the Portable Volumes node, click on the replication you want to cancel, and select 
Cancel Copy.

3 Select one of the following:

Cancel Operations that have not finished: Select this option to cancel only the copy 
operations that have not yet finished.

Cancel All Operations: Select this option to cancel all operations. 

4 If you selected Cancel All Operations, you can also erase the portable volumes.

For information on options for erasing portable volumes, seePortable Volume and Erase 
Portable Volume Attributes on page 81.

5 Click OK.
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Monitoring Portable Volume Replication Progress
1 Go to the Storage Management display for the source Storage Center.

2 In the Portable Volumes node, click on the Repl Baseline To [dest] node. Information 
on the replication is displayed in the view pane. 

The display shows the following:

• Summary of Replication Attributes: Shows the source and destination Storage 
Center, as well as bar charts showing portable volume space used and copying space.

• Portable Volumes Table: Shows all portable volume attributes in table form.

• Current Copying Jobs Table: Shows all copying job details in table form.

Restoring a Portable Volume at the Destination Storage Center
1 Go to the Storage Management display for the source Storage Center.

2 In the Portable Volumes node, click on the Repl Baseline To [dest] node and view the 
summary for the replication.

3 When all copying is complete and the portable volume state shows Ready to be 
Removed, remove the portable volumes.

4 On the destination Storage Center, plug in the source replication portable volumes on 
available USB ports. You can plug in the portable volumes in any order.

5 Once the portable volumes are plugged into the destination Storage Center, the Storage 
Center immediately reads in the replications and begins creating the replicated 
volumes.
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Monitoring Portable Volume Restore Progress
1 Go to the Storage Management display for the destination Storage Center.

2 In the Portable Volumes node, click on the Repl Baseline From [source] node. 
Information on the restore is displayed in the view pane. 

The display shows the following:

• Summary of Replication Attributes: Shows the source and destination Storage 
Center, as well as bar charts showing portable volume space used and copying space.

• Portable Volumes Table: Shows all portable volume attributes in table form.

• Current Restore Jobs Table: Shows all restore job details in table form.
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Using the Reports Viewer
The Reports viewer uses technology from Business Objects Crystal Reports to create 
and display reports. 

 To open the Reports viewer

• In the Viewers pane, click the Reports icon. The Reports viewer window appears.

The Reports viewer displays two panes: 

• Report Viewer: Displays an opened report.

• Saved Reports: Lists all saved reports in a table.

Report Viewer Pane Saved Reports Pane
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 To view a saved report

The Saved Reports pane lists all saved reports. To view a saved report:

• Double-click the report name in the Saved Reports pane. The report is displayed. 
Buttons available in the Report Viewer include:

 To delete a saved report
1 In the Saved Reports pane, click on the report you want to delete.

2 Click .

 To update a saved report
1 In the Saved Reports pane, click on the report you want to update.

2 Click .

Button Description

Export Report
Exports a report to a file. Format options include Crystal Report (.rpt), 
Adobe Acrobat Portable Document (.pdf), rich text format (.rpt), and 
comma-separated values (.csv).

Print Report
Sends the report to the selected printer.

Stop Refresh
Stops refresh data.

Refresh Data
Refreshes the data in the displayed report.

Scroll Bar
Scrolls page-by-page through the report.

Search Text
Searches for text within the report.

Magnification
Specifies the magnification level for the report display.
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Scheduling Automated Report Generation
Data Collector automatically generates reports based on the following:

• Globally via the Data Collector Properties—Automated Reports.

• Per Storage Center in the Storage Center Properties—Automated Reports. 

All automated reports are saved in the database and can be viewed at a later time via the 
Report Viewer. The reports can also be emailed to users or saved in a public directory so 
users can receive reports without having to log into Data Collector.

Note By default, Data Collector runs as a service without a user account. To save 
automated reports to a public directory that requires domain authentication, set up 
the Data Collector service with a domain user account through Windows 
Management Services. 

 To set up an email address for receiving automated reports

Note Before setting an email address to which you want to email automated reports, set 
up an SMTP server. See SMTP Server on page 17 for information on setting up an 
SMTP server.

1 From the Management menu, select User Properties.

2 In the General Properties, click Change.

3 Enter the email address to which you want to send automated reports. Click Test Email 
to verify the address. 

4 Click Apply Changes.

 To be notifed when a New Automated Report is available
1 From the Management menu, select User Properties.

2 Click Manage Events.

3 Click Change.

4 Select New Automated Report.

5 Click Apply Changes.

 To be notifed when report generation causes an error
1 From the Management menu, select User Properties.

2 Click Manage Events.

3 Click Change.

4 Select Automated Report Generation Errors.

5 Click Apply Changes.
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 To set up automated reports for all Storage Centers (global settings)
1 From the Management menu, select Data Collector Properties. 

2 Click Automated Reports.

3 Click Change.

4 Set the following:

Global Automated Report Default Settings: Select the reports you want to 
automatically generate for all Storage Centers, as well as the frequency of the report 
generation.

Global Automated Table Report Default Settings: Specify settings for IO Reports and 
Storage Reports.

Chargeback Automated Report Settings: Select Chargeback reports to generate: 
Chanrgeback and/or Chargeback Savings.

Automated Report Options:

• Store report in public directory: Stores automated reports in a public directory.

• Directory: Specifies the public directory in which to save automated reports.

• Attach automated report to email: Attaches and emails automated reports. 
Reports are emailed in PDF format.

• Attach table report to email: Attaches and emails table reports.

• Select file type for table reports: Specifies the file type for table reports.

Note Enterprise Manager sends emails to the email address specified in the User 
Properties. For instructions on specifying the Enterprise Manager email address, 
see To set up email notification on page 12.

5 Click Apply Changes.

 To set up automated reports for a Storage Center
1 Right-click on the Storage Center for which you want to set up automated reports and 

select Edit Settings.

2 Click Automated Reports.

3 Click Change.

4 Deselect Use the Data Collector Global Settings option.

5 Select the reports you want to automatically generate.

6 Click Apply Changes.
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Generating a Report Now
1 From the Management menu, select Data Collector Properties.

2 Click Automated Reports.

3 Click Generate Reports Now. The Generate Report Now dialog appears.

4 Select the reports you want to generate now.

Note The daily, weekly, and monthly reports created depend on the current Report 
Generation Settings. See Scheduling Automated Report Generation on page 94 for 
information on Report Generation Settings.

5 When report generation is complete, a message is displayed. Click Ok to close the 
message dialog.

6 Click OK to close the Data Collector Properties dialog.
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Introduction
The IO Usage report is a history report displaying performance rates. Use the IO Usage 
Report to compare IO rates and monitor the Storage Center to ensure there are no 
performance related problems. 

 To view IO Usage Reports
1 Right-click on a Storage Center, and select View > IO Usage Report. 

2 Select a time period to view, and click OK. The IO Usage Report appears:

Explorer Mode: Shows components of a Storage Center — volumes, servers, disks, 
and controllers — in a tree to the left of the report. 

Object Comparison Mode: Displays the Object Comparison view. See Comparing IO 
Usage Objects on page 99.

 To select objects displayed in the IO Usage Reports

1 When the IO Usage Report is displayed, click . The IO Usage 
Properties dialog appears.

2 Select (or de-select) objects to display in the report. 

Note Reducing the number of objects to view reduces the time required to update the IO 
Usage Report.

3 Click OK.

 To change the IO Usage Report view mode

• When the IO Usage Report is displayed, select either Explorer View or Object 
Comparison View from the pull-down menu located at the top right of the display.
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Comparing IO Usage Objects

 To select objects to compare
1 Make sure the IO Usage Report is displayed in Object Comparison View.

2 In the Object Selector pane, select the object group: Volumes, Servers, Disks, or 
Controllers.

3 Select the individual objects to compare using the Add Selected and Remove 
Selected buttons.

Object Selector Pane

Selected Objects Pane
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 To save an object comparison setting
1 After selecting the objects to compare, click Save.

2 Enter a name for the Comparison Configuration, and click OK.

 To load a Comparison Configuration
1 Click Load.

2 Select the configuration to load, and click OK.
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Introduction
As part of an overall Disaster Recovery Plan, replication copies volume data from one 
Storage Center to another Storage Center to safeguard data against local or regional data 
threats. 

Note By default, data is replicated from the source volume to the lowest storage tier of the 
destination volume. Use the Edit Replication Properties to change this default. 
See Editing Replication Properties on page 111.

Using Enterprise Manager, an administrator can set up a replication plan for Storage 
Centers that supports an overall Disaster Recovery strategy.

Replication Requirements
To replicate volumes from one Storage Center to another using Enterprise Manager 
requires the following:

Using the Portable Volume Option
To jump-start volume replications between Storage Centers, Enterprise Manager offers the 
Portable Volumes feature. The Portable Volume feature allows a site to replicate one or 
more volumes from one Storage Center to another via a removable USB disk. For 
information on using the Portable Volume feature, see Working with Portable Volumes on 
page 79.

Live Volume Option
To automatically swap the primary and secondary Storage Center roles of a pair of 
replicating volumes, Enterprise Manager offers the Live Volume feature. For more 
information on creating and managing Live Volumes, see Using Live Volumes on page 73.

Requirement Description

Storage Centers Both the source and destination Storage Centers must be added 
to the Enterprise Manager client. See Adding and Removing 
Storage Centers on page 8 for details.

iSCSI Remote Systems • On the source Storage Center, the destination Storage 
Center must be defined as an iSCSI Remote System. 

• On the destination Storage Center, the source Storage 
Center must be defined as an iSCSI Remote Connection.

See Configuring iSCSI Connections on page 105 for details.

QoS Definition A quality of service (QoS) definition must be set up for the 
replication. See Creating a Quality of Service (QoS) Definitions 
on page 106 for details.
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Replication, Live Volume, and Move Attributes 
Refer to the following list for descriptions of all replication, Live Volume, and move 
attributes.

Automatically Swap Roles
For Live Volumes only. Select this option to allow Enterprise Manager to automatically 
swap the roles of the primary and secondary volumes.

Controller
For individual destination volumes only. On a dual-controller Storage Center, specify the 
controller on which to activate the replicated volume.

Create Volume Folder Path on Destination
Creates the same folder structure for the replicated volume on the destination Storage 
Center.

Deduplication
For Asynchronous replication only. Enable this option to copy only the changed portions 
of the Replay history on the source volume, rather than all data captured in each Replay.

Delete Source volume mappings automatically when move starts
Deleting Source volume mappings means that no more traffic is coming into the source 
volume and the move can be finished quicker. If this option is not selected, the Source 
volume mappings must be deleted manually when the move is in progress. The move 
is not finished until the Source volume mappings are deleted. 

Delete Source volumes automatically when move is complete
Specify whether to delete source volumes automatically when move is complete.

Destination Volume Name Prefix
Enter a prefix to use for the replication. For replication operations, the default is Repl of. 
For Move operations, the default is Move of.

Destination QoS Definition
For Live Volumes only. Specifies the QoS definition to use on the destination Storage 
Center.

Folder
Destination folder for the replicated volume. Click Change and select a folder.

Min Amount for Swap
For Live Volumes with Automatically Swap Roles enabled. Specifies the minimum 
amount of storage space (in KB) required to be written on the secondary Storage Center 
before Enterprise Manager will swap roles.

Min Secondary % Usage for Swap
For Live Volumes with Automatically Swap Roles enabled. Specifies the minimum 
percentage of IO required on the secondary Storage Center before Enterprise Manager 
will swap roles.
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Name
For individual volumes only. Specify the name for the replicated volume on the 
destination Storage Center.

QoS Definition
Select a QoS definition to use for the simulated replication. For information on creating 
a QoS definition, see Creating a Quality of Service (QoS) Definitions on page 106.

Replicate Active Replay
For Asynchronous replication only. Enable this option to copy all writes from the active 
Replay area of the volume. Note that replicating active Replays can require significant 
bandwidth. For Live Volumes, the default is to Replicate Active Replays. If you disable 
this option for a Live Volume, the option is automatically enabled when Live Volumes 
swap roles either manually or automatically.

Replicate to Lowest Tier
Specifies how data is written to the destination volume of a replication. By default, data 
is replicated to the lowest tier.

Replication type
Select Synchronous or Asynchronous. Dell Compellent recommends using 
Asynchronous replication.

Save Restore Points
Enable this option to automatically save restore points. This is the default setting and 
Dell Compellent recommends always saving restore points.

Servers
Click Change and select the server to which you want to map the moved volumes.

Skip Initial Synchronization
Skips the initial data copy of Replays. Use this option to verify that the selected QoS 
definition can support the volume activity.

Storage Type
Select the storage type (available storage types depend on the destination Storage 
Center configuration).

Time as Primary before Swap
For Live Volumes with Automatically Swap Roles enabled. Specifies the minimum 
amount of time (in minutes) that the primary Live Volume must function as the Primary 
Live Volume before a swap is allowed. The default is 30 minutes.
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Configuring iSCSI Connections

 To configure on iSCSI connection for a remote Storage Center
1 Make sure the Storage Centers for which you want to configure iSCSI connections are 

available in Enterprise Manager. (For information on adding Storage Centers, see 
Adding and Removing Storage Centers on page 8.)

2 Select the Storage Center for which you want to create a Remote Storage Center iSCSI 
connection, and display the Storage Management view.

3 On the Storage Management view, right-click on the Remote Storage Centers node, 
and select Configure iSCSI Connections. A list of Storage Centers appears.

4 Select the Storage Center for which you want to configure the connection, and click 
Next.

5 Select the following:

Remote iSCSI Ports: Select the iSCSI ports on the remote Storage Center to connect 
to the local iSCSI ports.

Local iSCSI Ports: Select the iSCSI ports on the local Storage Center to connect to the 
remote iSCSI ports.

Network Speed: Select the speed for the network: T1, T3/100 Megabit, or Gigabit or 
greater.

Sync Remote Port Connections on Both Storage Centers: Enable this option to 
synchronize remote port connections on both Storage Centers.

Configure using NAT: Enable this option to configure the connection using Network 
Address Translation (NAT).

6 If you are using NAT, click Next. 

7 Set up the NAT IP address for the iSCSI ports on both Storage Centers. When you are 
finished, click Next.

8 Click OK to complete the configuration.
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Working with Quality of Service (QoS) Definitions
A Quality of Service (QoS) definition defines the following:

• Link characteristics used to break up IO for a fair distribution of link resources.

• Bandwidth limits (optional). A QoS definition can restrict replication to time periods you 
select. Because bandwidth limits require system overhead, use limits only when the link 
is shared with other traffic.

Note The Create QoS wizard appears automatically when you simulate or create a 
replication and no QoS definition exists for the source Storage Center.

Creating a Quality of Service (QoS) Definitions

 To create a QoS definition
1 Display the Replications viewer.

2 Select the Storage Center for which you want to create a QoS definition, and click 
Create QoS Node.

3 When the Create QoS wizard appears, enter the following:

• Name: Enter a name for the QoS Definition.

• Link Speed: Select a link speed that most closely represents your link or select 
Other to enter the appropriate link speed in the field presented. The link speed value 
is used to appropriately size and utilize replication link resources to the remote 
system. This setting defines the link attributes only. 

• Number of Links: Enter the number of links. If you have more than one link to the 
remote system, enter that number here. This adjusts the maximum bandwidth 
allowed without changing the communication link settings.

• BW Limited: Enable or disable bandwidth limits.

4 If you enabled bandwidth limits, click Next. A grid showing hours and days appears. 
Right-click on a time slot and/or days to set a limits.

5 Click Finish.
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Editing a Quality of Service (QoS) Node

 To edit a QoS node
1 Display the Replications viewer.

2 Select a Storage Center, and then click the QoS Definitions tab. A list of QoS 
definitions is displayed.

3 Right-click on the definition you want to edit, and select Edit Settings. The Edit QoS 
Node dialog appears.

4 Change the name, link speed, or bandwidth limits settings. If bandwidth limits is 
enabled, click Next to define the limits.

5 When you’ve finished editing the definition, click Finish.

Deleting a Quality of Service (QoS) Node

Note You can delete a QoS node only when the node is not currently used by a replication 
operation.

 To delete a QoS node
1 Display the Replications viewer.

2 Select a Storage Center, and then click the QoS Definitions tab. A list of QoS 
definitions is displayed.

3 Right-click on the definition you want to delete, and select Delete.

4 Click OK to confirm the delete.
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Creating Simulated Replications
Simulated replications allow you to estimate system requirements for replication. Simulate 
replications to determine an optimal balance of volumes, Replay schedules, bandwidth 
schedules, and recovery. 

 To create a simulated replication
1 Right-click on a Storage Center, and select Tasks>Replication>Simulate Replicate 

Volumes. The Replication wizard appears.

Note If a Quality of Service (QoS) definition has not been defined, the QoS Wizard 
appears. See Creating a Quality of Service (QoS) Definitions on page 106 to create 
a QoS definition.

2 Select the volumes for which you want to simulate replications, and click Next. 

3 Specify replication options, and click Next. 

For information on replication options, see Replication, Live Volume, and Move 
Attributes on page 103.

4 When the Simulate Volume(s) with Attributes window appears, verify the Simulate 
Replication settings, and click Start to begin the Simulated Replication. The 
Replication Results window appears.

5 When the status for each volume included in the replication has started successfully, 
click Finish.
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Creating Replications

Note If a Quality of Service (QoS) definition has not been defined, the QoS Wizard 
appears during the Create Replication wizard. See Creating a Quality of Service 
(QoS) Definitions on page 106 to create a QoS definition.

 To replicate volumes
1 Right-click on a Storage Center, and select Tasks>Replication>Replicate Volumes. 

The Replication wizard appears.

2 Select the destination Storage Center to which you want to replicate volumes, and click 
Next. The Select Volumes to Replicate dialog appears.

3 Select volumes to replicate, and click Next. 

4 Specify replication options to apply to all volumes.

For information on replication options, see Replication, Live Volume, and Move 
Attributes on page 103.

Note If more than one volume is included in the replication, these settings apply to the 
replication for all the volumes. You can edit individual volume replication settings 
before starting the replication.

5 Click Next. A summary of the replication settings appears.

6 If you want to edit the replication settings for a volume:

a Select the volume, and click Edit Selected. 
b Edit the replication settings for the volume, and click OK. 

7 To start replicating the volumes, click Start. Enterprise Manager starts the replication, 
and the Replication Results window appears. 

8 Click Next. The Replication wizard asks if you want to save the restore points. Dell 
Compellent recommends saving the restore points.

9 Click on Save Replication Restore State. The Save Replication Recover State Wizard 
appears. See Saving and Validating Replication Restore Points on page 110.
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Saving and Validating Replication Restore Points
Replication restore points include all information about current replications, including 
volumes being replicated, destination Storage Centers for the replications, and the QoS 
definitions used for the replications. If a Storage Center goes down, this information 
becomes the basis of a disaster recovery. 

 To save replication restore points for one or more Storage Centers
1 Access the Save Restore Points wizard:

• From the Replications viewer, click on the Save Restore Points option in the top 
right of the display.

or

• Select Replication Recovery>Save Restore Points.

2 Select the Storage Centers for which you want to save replication restore points.

3 Click Next. 

4 If you did not delete or abort replications, the system notifies you that it finished saving 
restore points. 

5 If you deleted or aborted replications, the Inactive Replication window appears.

To delete inactive restore points:

• Select replications that are no longer active, and click Delete selected Restore 
Points. 

To validate replications:

a Click Validate Replications. Enterprise Manager displays a list of replications. 
b Click on the replication you want to restore/restart, and click Restore/Restart 

Replication.
c Click on a valid replication for which restore points are already saved, and click 

Activate DR Site.

6 Click OK. 
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Editing Replication Properties

 To edit properties for an existing replication
1 Display the Replications viewer.

2 Click on the Replications tab.

3 Right-click on a replication, and then select Edit Settings. The Replication Properties 
dialog appears. For details on replication attributes, see Replication, Live Volume, and 
Move Attributes on page 103.

4 Edit the replication properties, and click OK to close the dialog.
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Moving Volumes
Moving volumes is similar to replication. However, when a volume is completely moved to 
the destination system, the replication stops. Use Move Volumes if you are doing either of 
the following:

• Completely replacing the current Storage Center with a new Storage Center and want 
all the volumes to move with it.

• Installing a second Storage Center controller and want to balance the load between the 
two systems.

 To move volumes to another Storage Center
1 In the Storage Center frame, right-click on the source Storage Center. From the 

shortcut menu, choose Task>Replication>Move Volumes. 

Note If a QoS has not been defined, the QoS Wizard appears. Follow the steps in Creating 
a Quality of Service (QoS) Definitions on page 106 to create a QoS definition.

2 When the Move Volumes wizard appears, select a Storage Center to which you want 
to move the volumes, and click Next. 

3 Select volumes to move, and click Next.

4 Select Move attributes, and click Next. For details on Move attributes, see Replication, 
Live Volume, and Move Attributes on page 103. A summary screen appears that shows 
all the volumes to be moved and the corresponding move attributes.

5 To change Move attributes for a volume:

a Select a volume from the list, and click Edit Settings.
b Edit the Move attributes for the volume, and click OK.

6 When you are ready to move the volumes, click Start. 

The Replication Move Progress window appears, displaying the name of the volume 
to be moved and the name of the destination volume. 

• Volume: Lists source volumes that are being moved.

• Destination Volume: Lists name(s) of the volumes at the destination Storage 
Center.

• State: Indicates the state of the Move process. Waiting, Mapping Broken, 
Replicating, Finished or Error.

• CMM Total: Amount of data that has been moved.

• Remaining: Amount of data on the volume that is left to be moved.

• Finished: Percentage of data that has been moved.

• Status: Gives details on the State of the Move process.

• If you did not select to have mappings deleted in the Select Attributes of Move 
window, delete them now by clicking Delete Mappings on Source Volume. The 
move is not complete until mappings are deleted.
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• If you did not select to delete the source volume in the Select Attributes of Move 
window, you can click Delete Source Volume. Deleting Source volumes is optional.

7 Click Finish.
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Importing Volumes from External Devices
The Import Volumes from External Devices option moves data located on third-party 
(non-Dell Compellent) storage arrays into a Dell Compellent Storage Center in an 
organized and controlled manner. 

Warning Do not load volumes from a Storage Center with this process. To move data from 
another Storage Center, use Move Volumes. See Moving Volumes on page 112. 

Before you start the load process, make sure that the Storage Center into which you are 
importing external data meets the following requirements:

• For pre-5.1 Storage Centers, the Storage Center must be licensed for synchronous 
replication.

• Storage Center has a disk folder with a prepared storage type for receiving the external 
data.

• Storage Center objects used in the load process—servers, volume folders, Replay 
profiles, and user properties—are already defined on the Storage Center. 

 To load volumes from external devices onto a Dell Compellent Storage Center
1 Right-click on a Storage Center, and select Tasks>Replication>Import Volumes 

from External Devices. The Import External Devices wizard displays an 
informational screen that details prerequisites for loading external data. When all 
prerequisites are met, click Next to start the wizard.

2 Select one or more external disks to load, and click Next. The Select Volume 
Properties window appears.

3 Select volume properties including name, volume folder, server, cache setting, 
Storage profile, and Replay profile. The default volume name is Volume of [serial 
number of external disk]. Cache setting, Storage profile, and Replay profile use the 
Storage Center defaults for those volume attributes. You can select multiple volumes at 
once when changing settings. 

4 Click Next. The Load Properties window appears. Select Load properties:

• Select the maximum number of volumes to load. To load all volumes at once, enter 
0. To load a smaller number of volumes, enter the number of volumes to load. 
Because the load process can be processor-intensive, do not load more then five 
loads at a time. The system loads volumes in the order in which they appear on the 
list. Move a volume up and down the list by selecting a volume and clicking the up 
and down arrow.

• Select a QoS Node to use for the load. 

• Select a disk folder in which to create the volumes. 

5 Click Next. The Load From External Devices window appears. The window monitors 
the load process for each external device including the amount of data that is left to load.
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Validating Replication Restore Points

 To validate replication restore points
1 From the Options menu, select Replication Recovery > Validate Replication 

Restore Points. Enterprise Manager reviews all saved replications and makes sure 
that they are still running. If they are not, the system presents disaster recovery 
options, including: 

• Good: The replication is up and running normally. 

• Warning: There is something wrong with the replication. Refer to the Status/Reason 
column for reasons why the replication is no longer running. This replication is 
eligible for disaster recovery. 

• Error: The replication is not running. Refer to the Status/Reason for reasons why the 
replication is no longer running. This could be because the destination system is no 
longer available or that the source and Destination volume are no longer up and 
running. 

2 If a replication is in the Warning or Error state, click Delete Non-Active Restore Points 
if you intended the replication to be deleted or aborted.

3 If a replication is in the Warning state, you can: 

• Click Activate a Disaster Recovery Site. This takes you to the activate disaster 
recovery wizard. Refer to Activating Disaster Recovery on page 198 for more 
information. 

• Click Restore or Restart to Original System. This takes you to the restart/restore 
to the original system wizard. Refer to Restarting or Recovering to the Source Site 
on page 199 for more information. 
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Viewing Replications for a Single System
The Replications view shows historical and current replication data, presents the progress 
of replications, and compares replications. 

• Right-click on a Storage Center, and select View > Replications. The Replications 
view appears.

In the upper left corner, click on either the Replication or QoS Definition tab.

Replications Tab
In the Replications window, click on the Replications tab. The Replications View appears. 

 To Save Restore Points 

• Click Save Restore Points. Refer to Saving and Validating Replication Restore Points 
on page 110.

 To Validate Restore Points 

• Click Validate Restore Point. Refer to Validating Replication Restore Points on 
page 115. 

Replication attributes

• Source System Attributes: Name and volume of the Source volume.

• Destination System Attributes: Name, Volume, and Restore Time of the destination 
system. The Restore Time is the date and time of the last frozen Replay. If you activate 
a disaster recover site or a Restore from the disaster recover site, this is the time of the 
Replay that will be restored. 

• CMM Attributes:
• Type: Replication type: Mirror or Copy. 

• State: Replication object state: If the state is synced, the replication is up to date. 

• Replay: Replay currently being Replicated. Active means that all frozen Replays 
have been Replicated. 

• Left: Amount of space left to get the replication into the synced state (in MB or GB). 

• Finished: Percentage of the replication that is finished. At 100%, the replication is 
synced. 

• Replication Attributes:
• Type: Async or Sync.

• State: Asynced copy, synced copy, or idle.

• Behind: An Async Replication can lag behind what is sent to the Destination volume. 
This is the amount of data lagging behind in KB, MB, or GB. 

• QoS Node: The QoS Definition that the replication is running through. 

• Copy Active: True if the replication copies the active Replay; false if it does not. 

• Deduplicate: True if the replication copies only the changed portions of the Replay 
history; false if it captures all data. 
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• Live Volume: Indicates whether the replicating volume is a Live Volume and shows the 
source and destination statuses.

When a replication is selected, the information pane displays data from the selected 
replication: 

Replays

• To the left, a table displays the Replays that are available on the Source volume. The 
Replay that is currently being Replicated displays a green arrow next to it. 

• To the right, a table displays the Replays on the Destination volume. The Destination 
Volume Replay displays the size, freeze time, and expire time. If you select a Replay on 
either table it automatically selects the corresponding Replay in the other table. 

Historical Progress

• The CMM MB Remaining chart shows the number of MB that are remaining for the 
replication to finish. 

• The CMM Percent Done chart gives you the percentage complete of the replication. 

• The Replication Behind chart shows you how far behind an Async Replication is at any 
given point in time. 

Historical IO Reports

Shows two charts for an historical perspective on how much IO each replication is doing. 

• The Replication IO Per Second chart shows the amount of IO operations the replication 
is doing in a second. 

• The Replication KB Per Second chart shows the amount of KB transferred by the 
replication in a second. 

QoS Nodes Tab
• Name: The name of the QoS definition. 

• Link Speed: The defined speed of the QoS definition. 

• BW Limited: True if the QoS limits the bandwidth. 

• BW Limit: If the QoS limits the bandwidth, the bandwidth limit.

• # Replications: The number of replications that use this QoS node. 

• CMM Left: The aggregate of value of the CMM left of all the replications that use this 
QoS definition. 

• Async Behind: The aggregate of value of the Async Behind value for all replications 
using this QoS definition. 

• CMM Finished: The aggregate of value of the percentage complete of all the 
replications that use this QoS definition. 

When a Replay is selected, the following information is displayed via tabs at the bottom of 
the display.

Replications

• Displays a table of all the replications associated with the QoS node. By double clicking 
on a replication it displays the Replication window with this replication selected. 
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Schedule

• Displays a grid of the schedule of the percentage usage of the Link Speed for the QoS 
node for all times throughout the week.

Progress Reports

Displays three charts, showing the historical progress of all the aggregate replications in 
the QoS definition. 

• The CMM MB Remaining chart displays the number of MB that are remaining for the 
replication to finish. 

• The CMM Percent Done chart displays the percentage complete of the replication. 

• The Replication Behind chart displays how far behind the Async Replication is at a given 
point in time. 

IO Reports

Displays historical perspective on the amount of  IO in all replications in the QoS definition.

• The Replication IO per Second chart shows the amount of IO the replication is 
transmitting in a second. 

• The Replication KB per Second chart shows the amount of KB transferred by the 
replication in a second. A line displays the bandwidth limit for the QoS definition at a 
given time so you can see how much of the bandwidth the QoS definition is using. 
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Using the Replication Viewer
The Replication Viewer shows replications for all Storage Centers. To view replications for 
all Storage Centers:

• In the Viewers frame, click Replications. 

The Replication Viewer displays information in two frames:

• Replication Information: Middle frame displays information about replications.

• Source Volume Replays: The bottom frame displays Replays, Historical Progress 
Reports, and Historical IO Reports.

Replication Information Frame
The information pane changes depending on whether you select a Storage Center or a QoS 
definition. 

Source System Information

Click on a system in the topology frame to display replication information about that system. 
The information is the same whether you click on a Replicating system (left frame) or 
Destination system (right frame).

To view all the replications and moves from the selected system, click the Replications 
from Systems tab. The Replications table displays:

• Source System Replications: Name and volume of the Source volume.

• Destination System Attributes: Name, volume, and Restore Time of the destination 
system. The Restore Time is the date and time of the last frozen Replay. If you activate 
a Disaster Recovery site or a Restore from the Disaster Recovery site, this is the time 
of the Replay that will be restored. 

CMM Attributes 

• Type: Replication type: Mirror or Copy. 

• State: Replication object state. If the state is synced, the replication is up to date. 

• Replay: Replay currently being Replicated. Active means that all frozen Replays have 
been Replicated. 

• Left: Amount of space left to get the replication into the synced state (in MB or GB). 

• Finished: Percentage of the replication that is finished. At 100%, the replication is 
synced. 

Replication Attributes 

• Type: Replication type: Async or Sync.

• State: Replication state: Async copy, synced copy, and so on.

• Behind: An Async Replication can lag behind the data that is sent to the Destination 
volume. This is the amount of data lagging behind in KB, MB, or GB. 

• QoS Node: The QoS Definition that the replication is running through. 

• Copy Active: True if the replication copies the active Replay; false if it does not. 
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• Deduplicate: True if the replication copies only the changed portions of the Replay 
history; false if it captures all data. 

To view the Replays of a specific replication, click on a replication in the Replication table, 
then click the Replays tab at the bottom of the window. 

• The left frame of the System Information Replays table displays Replays that are 
available on the source volume. A Replay that is currently being Replicated is indicated 
by a green arrow.

• The right frame of the System Information Replays table displays Replays on the 
Destination volume, including date and time the Replay froze data, the expiration time 
of the Replay, and the size of the Replay. Selecting a Replay on either table 
automatically displays the corresponding Replay in the other table. 

To view historical progress of a specific replication, click on a replication in the Replication 
table, then click the Historical Progress Reports tab at the bottom of the window. 

• CMM MB Remaining chart displays the number of MB that remain in the replication. 

• CMM Percent Done chart displays the percentage complete of the replication. 

• Replication Behind chart displays the amount of data the systems lags in an Async 
Replication, for any point in time. 

To view historical IO of a specific replication, click on a replication in the Replication table, 
then click the Historical IO Reports tab at the bottom of the window.

• Replication IO Per Second chart displays the amount of IO per second is being 
Replicated. 

• Replication KB Per Second chart displays the amount of KB transferred by the 
replication per second. 

QoS Definition Tab 

To view QoS information click on a system in the top topology frame. Then click the QoS 
tab. The system displays a list of QoS definitions defined for this system, including: 

• Name: Name of the QoS definition.

• Link Speed: Defined speed of the QoS definition. 

• BW Limited: True if the QoS limits the bandwidth. 

• BW Limit: If the QoS limits the bandwidth, the bandwidth limit.

• # Replications: The number of replications that use this QoS node. 

• CMM Left: The aggregate of value of the CMM left of all the replications that use this 
QoS definition. 

• Async Behind: The aggregate of value of the Async behind value for all replications 
using this QoS definition. 

• CMM Finished: The aggregate of value of the percentage complete of all the 
replications that use this QoS definition. 
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Editing a Replication Definition
To edit properties for an existing replication:

1 Display the Replication viewer.

2 Click on the Replications tab.

3 Right-click on a replication, and then select Properties. The Replication Properties 
dialog appears.

4 Change the following:

Copy Active: Enable or disable copying active data.

Deduplication: Enable or disable deduplication.

QoS Node: Select a QoS Node for the replication.

5 Click OK to close the dialog.
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Deleting a Replication
To delete a replication:

1 Display the Replication viewer.

2 Click on the Replications tab.

3 Right-click on a replication, and then select Delete. The Delete Replication dialog 
appears.

4 Select options for the delete:

Put Destination Volume in Recycle Bin: Enable this option if you want to move the 
destination volume to the Recycle Bin on the destination Storage Center.

Purge Destination Volume (Delete from Recycle Bin): Enable this option if you do 
not want to retain the deleted destination volume in the Recycle Bin.

Warning If you purge the destination volume, you cannot recover the volume—it is 
permanently deleted from the Storage Center.

Delete Saved Replication Restore Point: Enable this option to delete all saved restore 
points for the replication.

5 Click OK to complete the delete.
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Pausing a Replication

Note Only replications currently in a Running state can be paused.

To pause a replication:

1 Display the Replication viewer.

2 Click on the Replications tab.

3 Right-click on a replication, and then select Pause. 

Enterprise Manager pauses the replications. In the Replication Viewer, the replication 
shows a state of Paused.

Resuming a Replication
To resume a replication that was previously paused:

1 Display the Replication viewer.

2 Click on the Replications tab.

3 Right-click on a paused replication, and then select Resume.

Enterprise Manager resumes the replications.
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Introduction
Storage Center Charting Viewer displays real-time IO performance statistics for volumes, 
servers, disks, and controllers. Charting Viewer is accessible via Enterprise Manager or as 
a stand-alone application:

• If you are using Enterprise Manager, you can access the Charting View via the 
Enterprise Manager client. See Using Charting Viewer on page 129.

• If you do not have Enterprise Manager, download and install the stand-alone version of 
Charting Viewer. See Downloading and Installing Charting Viewer on page 127.
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Downloading and Installing Charting Viewer

Charting Viewer Requirements
Storage Center Charting Viewer requires the following:

• Microsoft Windows XP, Microsoft Windows Vista, or Microsoft Windows 7.

• Microsoft .NET Framework 2.0 or later

• Java Runtime Environment (JRE) 1.6

Charting Viewer Installation Process
To download and install Storage Center Charting Viewer:

1 Go to the Dell Compellent Customer Portal: http://customer.compellent.com

2 Locate and download the Charting Viewer Setup file.

3 Double-click on the setup file. The installation wizard appears.

4 Click Next. The License Agreement appears.

http://customer.compellent.com
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5 Click Yes to accept the license agreement. The installation wizard installs the Charting 
Viewer.

6 When the installation is complete, click Finish to exit the wizard. 
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Using Charting Viewer

Starting Charting Viewer
To start Charting Viewer from Enterprise Manager:

• Right-click on a Storage Center, and select View > Charting Viewer.

To start Charting Viewer as a stand-alone application:

1 From the Windows Start menu, select Compellent Technologies > Compellent 
Charting Viewer. The Login dialog appears:

2 Enter the following:

• Host Name: Enter the Storage Center host name for which you want to view charts.

• User Name/Password: Enter the Storage Center user name and password.

3 Click Login.
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Using Charting Viewer Controls
The Charting Viewer provides tool bars for controlling the Charting Viewer display.

• Data Gathering and Navigation Controls

• Charting Report Controls

Data Gathering and Navigation Controls

Use the following buttons to control data gathering and navigation:

Charting Report Controls

Use the following buttons to control how Charting Viewer reports are displayed:

Click … To …

Page forward in the display.

Page backwards in the display.

Select a time increment for the display.

Start data gathering.

Stop data gathering.

Select objects for which to gather information. See Setting Charting Viewer 
Properties on page 131.

Update data in all displayed charts.

Use … To …

Single Tab Display all statistics on one tab.

Auto-Scale Auto-scale the IO, KB, and/or Lat displays. If auto-scale is not selected, enter 
the scale to use in the charts.

Layout • For the Storage Center: FE and BE Same. Display Front End (FE) and 
Back End (BE) in one chart. Deselect to show in different charts.

• For individual objects: IO and KB Same. Display IO and KB data in one 
chart. Deselect to show in different charts.

Display Select statistics to include or exclude.
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Setting Charting Viewer Properties
To set Charting Viewer Properties:

1 When the Charting Viewer is displayed, click . The Charting 
Properties dialog appears.

2 Select the objects for which you want to gather and display information:

• Volume IO Usage: Retrieves and displays IO statistics for all volumes, volume 
folders, and individual volumes.

• Server IO Usage: Retrieves and displays IO statistics for all servers, server folders, 
and individual servers.

• Disk IO Usage: Retrieves and displays IO statistics for all disks, disk folders, and 
individual disks.

• Controller/Local Ports IO Usage: Retrieves and displays IO statistics for all 
controllers, individual controllers, and individual ports on a controller.

Note Charting Viewer always displays System IO Usage.

3 Click OK to close the dialog.
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Viewing Storage Center Charts
Charting Viewer provides the following chart types:

• System Charts

• Volume Charts

• Server Charts

• Disk Charts

• Controller/Port Charts

Viewing the System Chart
To view the system chart:

1 In the Charting Viewer navigation tree, click on the System icon. The System Chart 
window appears.

2 Click on a tab to view:

• KB Performance

• IO Performance

• System IO Pending

Viewing Volume Charts
To view the volumes chart:

1 In the Charting Viewer navigation tree, select the Volume icon, a volume folder or an 
individual volume. The Volume Chart window appears.

2 Click on a tab to view:

• Volumes IO

• Volumes latency

• Volumes IO Pending

Viewing Server Charts
To view the server chart:

1 In the Charting Viewer navigation tree, select the Server icon, a server folder or an 
individual server. The Server Chart window appears.

2 Click on a tab to view:

• Servers IO

• Servers Latency
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Viewing Disk Charts
To view the disks chart:

1 In the Charting Viewer navigation tree, select the disk icon, a disk folder or an 
individual disk. The Disk Chart window appears.

2 Click on a tab to view:

• Disks IO/Sec

• Disks KB/Sec

Viewing Controller and Local Ports Charts
To view the controller and local ports charts:

1 In the Charting Viewer navigation tree, select the Controllers icon, an individual 
controller, a port type icon, or an individual port. The Controller/Ports Chart window 
appears.

2 Click on a tab to view:

• Local Ports IO

• Local Ports Latency

• CPU/Memory (for controllers only)
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Saving a Chart as a PNG Image
To save a chart as a PNG image:

1 Right-click on the chart you want to save, and select Save As. 

2 Browse to and select the directory in which you want to save the chart image, and enter 
name for the file.

3 Click OK.
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Printing a Chart
To print a chart:

1 Right-click on the chart you want to print, and select Print. The Page Setup dialog 
appears.

2 Select Page Setup options:

• Paper Size: Select a paper size from the list of available options.

• Paper Source: Select Automatically Select or Only One.

• Orientation: Select Portrait or Landscape.

• Margins: Set the left, right, top, and bottom margins.

3 Click OK.
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Zooming In and Out
To zoom in on data in a chart:

• Click and drag to define the area you want to view.

To return the chart to default settings:

• Double-click on the chart.
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Introduction
Chargeback allows you to charge for storage consumption on Dell Compellent Storage 
Centers based on global and departmental cost settings. With Chargeback, you can:

• Select how to charge for storage consumption. For example, you can charge by total 
used storage or total configured storage. In addition, you can set the base cost for 
storage by disk class or by storage tier level.

• Set up departments for the purpose of billing storage and assign volumes to 
departments. You can define premium or discounts to apply to the global base cost, and 
add line items for additional billing items.
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Configuring Chargeback

Note Before configuring Chargeback, make sure all Storage Centers you want to manage 
with Chargeback have been added to Enterprise Manager. See Adding and 
Removing Storage Centers on page 8 for instructions on adding and removing 
Storage Centers.

To configure Chargeback:

1 Select the Chargeback viewer.

2 Click . Enterprise Manager connects to all Storage Centers and 
gathers information. The Configure Chargeback wizard appears.

3 Select whether to charge on volume allocation or volume configuration:

Charge on Volume Allocation - Recommended: Charges storage consumption 
based on volume allocation. If you select this option, select one of the following:

• Charge on difference between last automated Chargeback run: Charges for 
volume storage consumption changes from the last automated Chargeback run.

• Charge on the amount of space currently used by Volumes in Department: 
Charges for all volume storage currently in use by the department.

Charge on Volume Configuration: Charges for total configured storage on volume.

4 Select the Currency Format.

Note Cost units in Chargeback are based on the Currency Format selection. For example, 
if the Currency Format is United States, cost units are in dollars.
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5 Specify Replay and Fast Track options:

• Charge on Replay Usage for Volumes: Charges for Replay usage on volumes. If 
selected, enter the Cost per Replay.

• Charge Extra for volumes using Fast Track disk space: Charges a higher rate for 
Fast Track disk space. If selected, enter the % to increase cost if running on 
premium disk space.

6 Click Next. 
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7 At the top right of the dialog, pull down the menu and select the method for assigning 
base cost to storage: Disk Class or Advanced Options.

• Disk Class: For each available disk class, assign an amount to charge per specified 
storage space unit (megabyte (MB), gigabyte (GB) or terabyte (TB). The unit for 
Amount is dependent on the Currency Format. For US, amount is in dollars.

• Advanced Options: For each Storage Center, assign a cost for each available tier.

8 Click Next. The Chargeback Departments dialog appears:

9 Do the following:

• In the right pane of the dialog, create, edit, or delete departments. See Adding or 
Modifying Departments on page 144 for details. 

• For each department, add or remove volume assignments: Use the  and  
buttons to assign and unassign individual volumes or volume folders.
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10 Click Next.

11 Specify whether unassigned volumes should be assigned to a department:

• Yes: Assigns unassigned volumes to a department. Select the department for the 
unassigned disks:

Use Already Created Department: Select a department to which you want to 
assign all unassigned volumes.

Create New Department: Enter the name of a new department to assign 
unassigned volumes.

• No: Does not assign unassigned volumes to a department.
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12 Click Next. 

13 Specify Chargeback Attributes:

• Run Chargeback: Select how often to automatically run Chargeback: Every Day, 
Once a Week, Once a Month, or Once a Quarter. 

Daily reports are run at midnight each day; weekly reports are run at midnight on 
the specified day; monthly reports are run at midnight on the last day of the month; 
and quarterly reports are run at midnight on the last day of the quarter (March 31, 
June 30, September 30, and December 31).

• Select Day of Week: For Once a Week. Select the day of the week to run 
Chargeback.

14 Specify Chargeback Reporting options:

• Automatically save the Chargeback run in a report: Automatically saves a report 
for each Chargeback run.

• Select type of file to save report in: Select the format for Chargeback Run reports: 
CSV, Text, Excel, HTML, or XML.

• Select public directory to save report to: Enter the complete path for an existing 
public directory in which you want to save reports. The directory must be on the same 
server as the Data Collector.

• Save individual department reports: Saves individual department reports.

15 Click Finish.
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Adding or Modifying Departments
The Chargeback Configuration dialog for creating and modifying departments provides two 
frames: Available Volumes and Departments.

Creating a Department
To create a department:

1 In the Departments frame, click . The Create New Department 
dialog appears.
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2 Enter Department Attributes: Department Name and Account Number.

3 Enter Contact Information: Contact Name, Contact Email, and Contact Phone Number.

4 Enter Pricing Settings:

• Price Multiplier: Enter a percent to apply to global cost (Disk Class or Advanced 
Options), and select Premium to increase the cost or Discount to decrease the cost.

Premium: To apply a premium charge, enter the percent by which to increase the 
global cost. For example, 10 applies a 10% surcharge.

Discount: To apply a discount, enter the percent by which to decrease the global 
cost. For example, enter 5 to apply a 5% discount.

The default Price Multiplier is 100; that is, 100% of the global cost.

• Starting Base Price: Enter a base price for storage. The default is 0.

• Base Price Covers 1st: Enter an amount of storage after which global cost and 
price multipliers are applied.

5 Add or edit line items as needed:

To add a line item:

a Click . The Add New Line Item dialog appears.

b Enter the following:

• Name: Enter a name for the line item.

• Description: Enter a description for the line item.

• Cost: Enter the cost for the line item. 
c Click OK.

To edit a line item:

a Select the line item you want to edit, and click .
b Edit the line item as needed, and click OK.

To delete a line item:

• Select the line item you want to delete, and click .

6 When you having finished defining the department, click OK.
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Editing a Department
To edit a department:

1 In the Departments frame, click . 

2 Edit the department as needed. For information on Department options, see Creating a 
Department on page 144.

3 When you are finished editing the department, click OK.

Deleting a Department
To delete a department:

1 In the Departments frame, select a department and click . 

2 Click Yes to delete the department.

3 Click OK to close the Department dialog.
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Viewing Chargeback Reports
During Chargeback configuration (see Configuring Chargeback on page 139), the 
frequency of automatic Chargeback runs was set. You can view the Chargeback reports 
generated from a previous Chargeback run or you can run Chargeback to generate new 
reports.

Running Chargeback to Create New Reports
To create a new Chargeback report for the current date and time:

1 Select the Chargeback viewer.

2 In the top right of the display, click . 

Chargeback runs and then displays the resulting reports.

Viewing An Existing Chargeback Report
To view Chargeback Reports for an existing run:

1 Select the Chargeback viewer.

2 In the top right of the display, use Chargeback Run selection toolbar to select the run for 
which you want to view reports:

The Chargeback reports for the selected run are displayed.



148 Enterprise Manager 5.5 User Guide

Chargeback Report Descriptions
For each Chargeback run, the following reports are generated:

• Departments Chart

• Departments Table

• Savings vs. Traditional SAN

Departments Chart
The Department Chart shows a bar chart of all the departments. For each department 
represented by a bar, the bar shows the sum of all charges to the department for the 
Chargeback run.

Departments Table
The Departments Table displays an expandable tree of Chargeback Departments and 
volumes associated with each Department. 

The table contains the following columns:

• Name: Department or volume name.

• NumVolumes: Number of volumes associated with this department.

• Total Cost: Total amount charged by the department or volume.

• Total Size: Amount of space used by the department or volume.

• Base Cost: Base starting cost assigned to this department.

• Base Size: Amount of storage the base price covers before the department is charged 
for storage.

• Tier 1, 2, 3 Cost: Cost charged to the department or volume located in Tier 1, 2, or 3 
storage. 

• Tier 1, 2, 3 Size: The amount of space used by the department or volume located in Tier 
1, 2, or 3 storage. 

• Contact Information: Name, Phone, and Email of the contact person or department.

• Account Number: Unique number assigned when the department was created. Can 
be changed in Chargeback Department Properties.

• Config Cost: Cost the Department would be charged based on the configuration costs 
of the disk classes. Config cost does not include the cost of the Price Multiplier or the 
Starting Base Price).

• Multiplier: Amount by which cost is multiplied.

• Line Items: Cost of individual line items.

When a department or volume is selected, the bottom half of the window presents the total 
space and cost for the department. The chart indicates the amount a Department is being 
charged compared to the original configured cost.
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To edit Department properties:
1 In the Departments table, right-click a Department, and select Properties. The Edit 

Department window appears.

2 Edit department properties, and click OK.

To save a Department report to a file:
1 In the Departments Table, right-click on a Department, and select Save Report.

2 Select an output type: CSV, Text, Excel, HTML, XML, or PDF.

3 Specify a name for the saved report, and click OK.

Savings vs. Traditional SAN
The Savings vs. Traditional SAN charts display estimated cost and storage space savings 
realized by using a Dell Compellent Storage Center as compared to a traditional SAN 
configuration. The estimated savings are computed on a per Storage Center basis.

Note All cost estimates for Storage Centers and traditional SANs used in the Savings vs. 
Traditional SAN reports are based on the costs currently configured in Chargeback. 
See Configuring Chargeback on page 139 for information on setting up costs for 
Chargeback.

Dynamic Capacity Savings 

The Dynamic Capacity Savings chart displays an estimated amount of cost and storage 
space savings realized by using a Storage Center with Dynamic Capacity as compared to 
a traditional SAN configuration. 

Storage Centers allocate space as needed; whereas a traditional SAN allocates space 
when a volume is created. The Dynamic Capacity Savings Report displays:

• Total Cost for a Storage Center to store active data (all the active space used for all 
volumes using the prices set for Chargeback). This cost does not include Replays or 
space used by RAID overhead.

• Total Cost for a traditional SAN to have the same amount of space available to servers 
using the prices set for Chargeback.

• Cost Savings realized by using Dynamic Capacity rather than a traditional SAN.

• Storage space saved by using Dynamic Capacity rather than a traditional SAN.
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Data Instant Replay Savings 

The Data Instant Replay Savings chart shows the estimated cost and storage space 
savings realized by using Storage Center Data Instant Replays as compared to traditional 
SAN point-in-time-copies.

Data Instant Replay allocates space for a Replay only when data is written and saves only 
the delta between Replays; a traditional SAN allocates space for every point-in-time-copy.

Data Instant Replay Savings chart displays:

• Total Cost for a Storage Center to store historical data by adding all the actual space 
used for all volumes.

• Total Cost for a traditional SAN to have the same amount of historical data available.

• Estimated savings derived by subtracting the Total Cost from the Traditional SAN Total 
Cost.

• Estimated storage space savings derived by subtracting the Total Storage Space from 
the Traditional SAN Total Storage Space.

Data Progression Savings

The Data Progression Savings chart shows the estimated cost savings realized by using a 
Storage Center with Data Progression as compared to a traditional SAN. For information 
on how Storage Center Data Progression works, see the Storage Center Manager User 
Guide.

Data Progression Savings chart displays:

• For each storage tier, Storage Center cost and the cost saved compared to a traditional 
SAN if all data is stored on a single tier or RAID 10.

• Total cost for using Storage Center compared to the total cost of a tradition SAN.
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Green Reports
Green Reports show the energy and CO2 savings realized by using a Storage Center as 
compared to a traditional SAN.

Setting Green Properties
Green Properties determine the values to use for calculating energy savings displayed on 
the Green Savings Report.

Note For details on Green Properties, refer to Guidelines for Setting Green Properties on 
page 152.

To set Green Properties:

1 Select the Chargeback viewer.

2 Click . The Green Properties dialog appears.

3 Specify values for the following items:

• Carbon Dioxide Produced: Enter the average amount of CO2 produced per disk in 
kWh in pounds. The default is 1.341.

• Drive Power Used: Enter the total amount of watts used per disk. The default is 
22.00.

• Power Cost: Enter the average cost of power per kWh. The default is 0.100.

• Convert to Annual: Displays the fixed multiplier used to calculate annual kWh from 
disk watt usage. Fixed value is 8.761.

4 Click OK to close the dialog.
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Guidelines for Setting Green Properties
Use the following resources as guidelines for setting Green Properties:

Average Power Cost per US Region

For average power cost per region in the United States:

http://www.eia.doe.gov/cneaf/electricity/epm/table5_6_b.html

Power Consumption Specifications for Storage Center Components

For specifications on Storage Center power consumption by component, refer to the 
following table:

Device Power (watts)
Component† Data Center††

15K.5 (146 GB) 24.00 80.00

10K.7 (146 GB) 22.00 73.30

15K.5 (300 GB) 26.50 88.30

10K.7 (300 GB) 25.00 83.30

NS 10K (400 GB) 17.25 57.50

ES.1 (750 GB) 19.00 63.30

ES.2 (1 TB) 19.00 63.30

SC 020††† 353.00 1176.50

SC 030††† 360.00 1199.90

NAS††† 187.00 623.30

† Assumes active IO with power supply and fan energy losses included.

†† Assumes adjustment of 3.33 times component power consumption to compute total data center power 
consumption.

††† Assumes maximum hardware configuration.

http://www.eia.doe.gov/cneaf/electricity/epm/table5_6_b.html
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Viewing Green Reports
To view Green Reports.

1 Select the Chargeback viewer.

2 Click the Savings vs. Traditional SAN tab.

3 Click the Green Savings Report tab. The Green Savings Report appears.
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Introduction
The Threshold Alerts viewer allows you to do the following:

• Run threshold queries that allow you to gather up-to-the-minute usage data on IO, 
storage, and replications. See Running Threshold Queries on page 161.

• Set up threshold definitions and then apply the thresholds to automatically monitor 
Storage Center IO, storage, and replication usage. See Creating and Applying 
Threshold Definitions on page 157.

• View current and past threshold alerts. See Using the Threshold Alert Viewer on 
page 162.
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Creating and Applying Threshold Definitions
Enterprise Manager provides three types of thresholds, each of which corresponds to a 
Storage Center usage resource:

• IO Usage

• Storage Usage

• Replication Usage

Each threshold type, in turn, includes a target class of objects to which it can be applied. 
For example, an IO Usage threshold can be defined to apply to an entire Storage Center, 
volumes, servers, disks, controllers, or local ports; a Storage Usage threshold can be 
defined to apply to an entire Storage Center or volumes; a Replication Usage threshold can 
be defined to apply to Replications or QoS nodes.

After defining the threshold type and target object class, you then apply the threshold to one 
or more individual objects in the target class. For example, you can set up a Storage Usage 
threshold for the target object class Volumes, and then apply the threshold to specific 
volume folders or individual volumes. The following tables lists all threshold types and 
corresponding classes and threshold definitions.

Threshold Type/Class Available Threshold Definitions
IO Usage
Storage Center FE IO/Secs

FE KB/Sec

IO Pending

Volumes IO/Sec

KB/Sec

Latency

IO Pending

Servers IO/Sec

KB/Sec

Latency

Disks IO/Sec

KB/Sec

Latency

Controllers IO/Sec

KB/Sec

CPU%

Memory%
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Creating a Threshold Definition
To create a Threshold Alert:

1 In the Viewers frame, click Threshold Alerts. The Threshold window appears.

2 Click the Threshold Definitions tab at the top of the window.

3 Click New Definition. The Alert Threshold Definition Configuration window 
appears.

Local Ports IO/Sec

KB/Sec

Latency

Storage Usage
Storage Center Usage

Growth

Volumes Usage

Active Growth

Replay Growth

Actual Growth

Replay Space

Actual Space

Replication Usage
Replication Amount Remaining

Percent Complete

QoS Nodes Percent Used

Threshold Type/Class Available Threshold Definitions
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4 Set up the threshold:

a Select the threshold type IO Usage, Storage Usage, or Replication Usage.
b Select the threshold target object class.
c Select the Threshold Definition for the type and class.
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5 Select Threshold attributes:

a Enter a unique Threshold Definition Name.
b Enter a value for the Threshold above which the system triggers an alert.
c Select to send an email when the threshold is met.
d Select the number times the threshold must be exceeded before sending out an 

email.
e Optionally, set a time and/or day constraint on when the threshold should be 

checked.

6 Click Finish. The threshold definition is created and listed in the Threshold Definitions 
table.

Applying a Defined Threshold
After defining a threshold, apply the threshold to specific Storage Center components 
objects.

To apply a threshold to one or more Storage Center objects:

1 In the Viewers frame, click Threshold Alerts. The Threshold window appears.

2 Click on Threshold Definitions.

3 In the list of Threshold Definitions, click on a definition that is not applicable to all objects. 
(That is, the All Objects column in the Threshold Definitions shows False.)

4 Click New Objects. The Alert Threshold Definition Configuration window appears, 
listing the available Storage Centers.

5 Select the objects for which you want to apply the threshold:

6 When you are finished selecting objects, click Finish.

Editing a Threshold Definition
To edit an existing threshold definition:

1 In the Viewers frame, click Threshold Alerts. The Threshold window appears.

2 Click the Edit Definition tab at the top of the window. The Alert Threshold Definition 
Configuration window appears. You can edit the name of the definition, the error 
threshold value, email notification, number of threshold iterations before email is sent, 
and time/day concurrents for checking the threshold.

3 Click Finish.

Deleting a Threshold Definition
To delete a definition:

1 In the Viewers frame, click Threshold Alerts. The Threshold window appears.

2 Click the Delete Definition tab at the top of the window. 

3 The system asks you to confirm. 

4 Click Yes. 
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Running Threshold Queries
In contrast to threshold definitions which Enterprise Manager constantly watches, you can 
create, save, and run threshold queries to immediately monitor Storage Center usage. To 
run a threshold query:

1 In the Viewers frame, click Threshold Alerts.The Threshold window appears. 

2 Click on the Threshold Queries tab. The Threshold Query window appears. 
(Previously saved queries appear in a frame to the left of the Query window.)

3 If you want to save the query:

a Enter a name for the query.
b Select Public to make the Query available to all users.

4 Set up the query:

a Select the scope of the threshold: either All Storage Centers or a specific Storage 
Center.

b Select the Threshold Type: IO Usage, Storage Usage, or Replication Usage.
c Select the Threshold Class. Available threshold classes are dependent on the 

selected Threshold Type.
d Select the Threshold Definition. Available Threshold Definitions are dependent on 

both the selected type and class.
e Select the start and end time for the query.
f Enter the threshold value.

5 Click Run Query. The results of the query appear in the table in the middle of the 
window. Right-click on a row in the table to view the data in a tree. 

6 Using the Reset, Save, Edit, and Export features:

• Click Save to save the query definition. 

• Click Edit to edit the definition of an existing query.

• Click Reset to return all the values in the query toolbar to original values.

• Click Save Query Results to export the results of a query.
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Using the Threshold Alert Viewer
The Threshold Alerts Viewer displays alerts generated by Threshold Queries and 
Definitions.

Current Threshold Alerts
Alerts in the Current alert table are for Storage Center objects that currently exceed their 
assigned threshold definition. 

To view Current Threshold Alerts:

1 In the Viewers frame, click Threshold Alerts. The Threshold Alerts window appears. 

2 Click the Current Threshold Alerts tab. The current alerts tab shows all the objects 
(systems, disks, volumes) that have a value above a defined Threshold the last time 
Threshold Alerts were run. Storage Usage runs once a day; IO Usage runs every 15 
minutes. By default, the system displays All Definitions and All Types.

3 Filter the list by selecting an individual Storage Center, Alert Definition, and/or Alert 
Type.

To save the alert data:

1 In the Threshold Alerts viewer, click on either the Current Threshold Alerts tab or the 
Historical Threshold Alerts tab.

2 Click Save. The Save Threshold Alerts window appears. 

3 Enter the following:

• Select Current Threshold Alerts and/or Historical Threshold Alerts. 

• Select the output type: CSV, text, Excel, HTML, XML, or PDF. 

• Browse to or enter a file name.

4 Click OK.

To update current alert data:

1 Select an Alert. 

2 Click Update. 

To view the Alert Definition that generated an Alert, in the Current Alerts window:

1 Right-click on an Alert. The current alert shortcut menu appears.

2 From the Alert shortcut menu, select Go to Definition.

3 The Threshold Definition window appears. The Alert Definition that triggered the Alert is 
highlighted.

To view the Storage Usage or IO Usage:

1 Right-click an Alert. The current alert shortcut menu appears.

2 From the Alert shortcut menu, select a Server, and then select either Show in Storage 
Usage Tab or Show in IO Usage Tab. 
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Historical Threshold Alerts
Alerts in the historical alert table are for Storage Center objects that no longer exceed their 
assigned threshold definition, but did at some point in the past.

To view Historical Threshold Alerts:

1 From the Viewers frame, click Threshold Alerts. 

2 Click the Historical Threshold Alerts tab. The Historical Threshold Alerts window 
appears.

3 Right-click the Alert to view the Historical Threshold Alerts shortcut menu.

• View the alert definition.

• View the Storage Center window (either IO Usage, Storage Usage, or Storage 
Center Explorer) that displays all statistics for this object.

• Delete the threshold alert from the database.

The upper left part of the tab allows you to qualify the number of alerts by selecting a 
threshold alert definition.

• Select All Definitions to filter the table by type, class, and definition.

• Save the data.

Update the table with current information.
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Introduction
The Enterprise Manager Servers Viewer gathers and displays operating system views of 
physical and virtual servers on the Storage Centers.

Supported Server Types
Servers Viewer can gather, display, and manage information from the following server 
types:

• For information on installing Server Agents, refer to the Enterprise Manager Installation 
and Setup Guide.

• For information on Storage Center NAS, refer to the Storage Center NAS Storage 
Solution Setup Guide and the Storage Center NAS Storage Solution User Guide.

• For information on Dell Compellent zNAS, refer to the Storage Center zNAS Storage 
Solution User Guide.

Server Icons
On the Servers Viewer, Enterprise Manager uses icons to denote the server type.

Server Type Description

Microsoft Windows Server 2003
Microsoft Windows Server 2008 
(including Microsoft Hyper-V)

For Microsoft Windows Servers, Enterprise Manager gathers 
information via a Server Agent for Microsoft Servers. 

Microsoft Windows
Storage Server (WSS)
2008, SP 2, Enterprise

Edition (x64) with Supermicro 
AOC-SIMSO – IPMI daughter 
card

For Microsoft Windows Storage Servers, Enterprise Manager 
gathers Fan Speed, Temperature, Voltage, and Power Supply 
information for the NAS. In addition, Enterprise Manager provides 
control options for the NAS: clearing the System Event Log 
(SEL), powering off, and resetting power. See Viewing and 
Managing a NAS or zNAS Server on page 186.

VMware vCenter or
ESX 3.5/4.0/4/1

For VMware vCenter or ESX virtual servers, Enterprise Manager 
gathers information from the VMware vCenter Management 
Server. 

Dell Compellent zNas For zNas, Enterprise Manager gathers and displays information 
for the Nas. 

Icon Server Type

Microsoft Windows Servers
Microsoft Windows Storage Servers

Microsoft Windows 2008 Server Hyper-V Management 
Server

Microsoft Windows Hyper-V Virtual Server
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VMware vCenter Management Server

Virtual Cluster

Icon Server Type
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Registering a Server
To include a physical or virtual server in the Servers Viewer, you must register the server 
with the Enterprise Manager Data Collector. For Microsoft Windows Servers, including 
Microsoft Windows Storage Servers, you must install a Dell Compellent Server Agent for 
Microsoft Servers on the server before registering the server.

Note Before registering a Microsoft Windows Server, make sure the Server Agent for 
Microsoft Servers is installed and running on the server. See the Enterprise Manager 
Installation and Setup Guide for information on installing a Server Agent for Microsoft 
Servers.

To register a server:

1 In Enterprise Manager, display the Servers viewer.

2 Click Register Server. The Register Server dialog appears.

3 Enter the following:

Select Operating System: Select the operating system of the server: Microsoft 
Windows 2003/2008 or VMware vCenter or ESX 3.5/4.0/4.1 or zNas.

Host/IP: Enter either host name or IP address for the server. For VMware ESX servers, 
enter the IP address of the VMware vCenter Management Server.

Port: Enter the port for the server. The default is 27355.

User Name/Password: For non-Microsoft Windows Servers. Enter an administrator 
username and password for the server.

Use https protocol: For non-Microsoft Windows Servers. Select this option to use https 
protocol to connect to the server.

IPMI Interface IP Address: For Nas only. Enter the IP address of the IPMI interface 
card.

IPMI Interface User: For Nas only. Enter the IPMI username.

IPMI Interface Password: For Nas only. Enter the IPMI password.

Automatically Manage on Storage Center: Select this option to automatically create 
and manage the server (and all virtual servers) on the Storage Center. 

Select Parent Folder: Select a Servers Viewer parent folder for the server.

4 Click Finish.

Enterprise Manager registers the server with the Data Collector and then displays the 
server in the Servers Viewer.
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Manually Mapping a Server Agent to a Storage Center Server
If necessary, you can manually map a registered Server Agent to a Storage Center server 
using the Server Agent Server Properties Storage Center Server tab.

1 In the Servers Viewer, right-click on the server you want to manually map to a Storage 
Center server and click Edit Settings. The Server Agent Server Properties appear.

2 Click Storage Center Servers.

3 To add a mapping to a Storage Center server:

a Click Add.
b Select a Storage Center from the list of available Storage Centers, and click OK.
c Select the server to which you want to map the Server Agent, and click OK.
d Click OK to close the Server Agent Server Properties dialog.

4 To remove a mapping:

a Select the mapping you want to remove, and click Remove.
b Click OK to close the Server Agent Server Properties dialog.



170 Enterprise Manager 5.5 User Guide

Creating Folders for Servers
You can create folders for organizing servers in the Servers Viewer. 

To create a folder:

1 In Enterprise Manager, display the Servers viewer.

2 Right-click on the Servers icon, and select Create Folder. The Folder Create dialog 
appears.

3 Enter a name for the folder, and select the location for the folder.

4 Click OK.
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Moving a Server to Another Folder
To move a server to another folder:

1 In Enterprise Manager, display the Servers viewer.

2 Right-click on the server you want to move to another folder, and select Edit Settings. 
The Server Agnet Server Properties dialog appears.

3 Click Parent Folder.

4 Click Change.

5 Select a parent folder for the server, and click Apply Changes.
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Assigning a Virtual Server to a Storage Center

Note Only servers that are not set up to be automatically managed on a Storage Center 
can be assigned to a Storage Center. See Server Agent Server Properties Dialog on 
page 190 for information on enabling or disabling the Automatically Manage on 
Storage Center option.

To assign a virtual server on the Servers Viewer to a Storage Center:

1 Right-click on a virtual server that is not automatically managed on the Storage Center. 

2 Select Assign Virtual Server - [Storage Center].

Enterprise Manager gathers information on the server from the Storage Center. If the server 
does not exist on the Storage Center, the server cannot be assigned to the Storage Center.
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Setting Global Properties for all Server Agents
To set global properties for gathering Microsoft Windows server information from Server 
Agents for Microsoft Servers:

1 In the Viewers pane, click the Servers icon.

2 In the top right of the display, click Edit Settings. The Data Collector Properties dialog 
appears.

3 Click Server Agent. 

4 Click Change.

5 Specify the following:

• Gather Server Agent Information automatically every hour: Gathers Server 
Agent Information automatically every hour.

• Get Stats for last (# Days): Enter the number of days for which you want to gather 
statistics.

• Allow Data Collector to automatically run Space Recovery: Enable this option to 
allow the Data Collector to automatically run Space Recovery.

6 Click Apply Changes.
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Scheduling Automatic Space Recovery

Note Free Space Recovery is available only for Microsoft Windows Servers on which a 
Dell Compellent Server Agent for Microsoft Servers is installed and running. For 
information on installing Server Agents, refer to the Enterprise Manager Installation 
and Setup Guide.

Note For servers running iSCSI HBAs, Enterprise Manager does not automatically 
recognize the WWNs for the server. To populate the list of WWNs and run Space 
Recovery, you must manually map the server to the Storage Center(s). See Manually 
Mapping a Server Agent to a Storage Center Server on page 169 for details.

Space Recovery finds and recovers unused disk space as reported by Windows. The 
amount of space that can be recovered depends on the frequency and expiration of Storage 
Center Replays. In general, more frequent Storage Center Replays with shorter expiration 
times result in more recoverable space. To be eligible for release, a Replay must be expired 
with no Storage Center View Volumes attached.

Space Recovery Requirements
Space Recovery requires the following:

• Space Recovery can be run only on a Windows NTFS file system.

• Space Recovery can recover space only on disks initialized by Windows as Basic; that 
is, Space Recovery cannot recover space on disks initialized by Windows as Dynamic. 

• Space Recovery cannot recover space from volumes that were striped or mirrored by 
Windows mirroring utilities. 

Space Recovery Recommendations
Follow these guidelines for running Space Recovery:

• Schedule Space Recovery to run once per week during off hours.
Although you can run Space Recovery immediately on any volume, to maximize the 
amount of space recovered, schedule Space Recovery to run once per week.

• View storage trends on volumes running Space Recovery to see progressive results.
Because regularly-scheduled Space Recovery operations gradually result in more 
space recovery, view storage trends on volumes running Space Recovery to see 
progressive results. 

Automatic Space Recovery Controls
Automatic Space Recovery is controlled by three hierarchical properties dialogs:

• Data Collector - Server Agent Properties: Use the Data Collector Server Agent 
Properties to enable automatic Space Recovery for all servers and volumes, and 
optionally set a global default schedule for all servers and all volumes. See Enabling 
Space Recovery and Setting a Global Space Recovery Schedule on page 175.
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• Server Agent Server Properties: If Space Recovery is enabled, use the Server Agent 
Server Properties to set a default Space Recovery schedule for all volumes on a server. 
In addition, use this dialog to specify whether a volume can also schedule automatic 
Space Recovery. See Scheduling Space Recovery for All Volumes on a Server on 
page 176 and Server Agent Server Properties Dialog on page 190.

• Server Agent Volume Properties: If automatic Space Recovery is enabled and the 
Server Properties allow volumes to schedule Space Recovery, use this dialog to set a 
Space Recovery schedule for the individual volume. See Scheduling Space Recovery 
for an Individual Volume on page 178 and Server Agent Volume Properties Dialog on 
page 192.

Enabling Space Recovery and Setting a Global Space Recovery 
Schedule
To enable Space Recovery and set a global schedule:

1 In the Viewers pane, click the Servers icon.

2 In the top right of the display, click Edit Settings. The Data Collector properties dialog 
appears.

3 Click Server Agent.

4 Click Change.

5 Specify the following:

• Enable the Allow Data Collector to automatically run Space Recovery option.

• Select a time to automatically run Space Recovery.

6 Click Apply Changes.
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Scheduling Space Recovery for All Volumes on a Server
To schedule Space Recovery for all volumes on a server:

1 Make sure that Space Recovery is enabled. See Enabling Space Recovery and Setting 
a Global Space Recovery Schedule on page 175.

2 In the Viewers pane, click the Servers icon.

3 Right-click on the server for which you want to set a schedule for all volumes, and select 
Edit Settings. The Server Agent Server Properties dialog appears.

4 Click Space Recovery.

5 Click Change.

6 Specify the following:

• Allow volumes on this server to schedule Space Recovery: Enable this option 
to allow volumes on the server to schedule Space Recovery for the volume.

• Set default Space Recovery schedule for volumes on this server: Select this 
option to set a default Space Recovery schedule for all server volumes.

• Run: Select the default schedule run time: Every Day, Once a Week, or Once a 
Month. For Once a Week, select the day of the week to run Space Recovery; for 
Once a Month, select the day of the month to run Space Recovery.

Note Scheduled Space Recovery runs at the time specified on the Data Collector Server 
Agent Properties dialog. See Enabling Space Recovery and Setting a Global Space 
Recovery Schedule on page 175.

• Apply server settings to all volumes on this server: Select this option to apply 
the new default schedule to all volumes on the server.

7 Click Apply Changes.
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Allowing a Volume to Schedule Space Recovery
To allow an individual volume to schedule Space Recovery:

1 Make sure that Space Recovery is enabled. See Enabling Space Recovery and Setting 
a Global Space Recovery Schedule on page 175.

2 In the Viewers pane, click the Servers icon.

3 Right-click on the server for which you want to allow one or more volumes to schedule 
Space Recovery, and select Edit Properties. The Server Agent Server Properties 
dialog appears.

4 Click Space Recovery.

5 Click Change.

6 Specify the following:

• Allow volumes on this server to schedule Space Recovery: Select this option to 
allow volumes to schedule Space Recovery.

• Apply server settings to all volumes on this server: Select this option to apply 
the new settings to all volumes on the server.

7 Click Apply Changes.
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Scheduling Space Recovery for an Individual Volume
1 Make sure that Space Recovery is enabled. See Enabling Space Recovery and Setting 

a Global Space Recovery Schedule on page 175.

2 Make sure that the volume is allowed to set a Space Recovery Schedule. See Allowing 
a Volume to Schedule Space Recovery on page 177.

3 In the Viewers pane, click the Servers icon.

4 Right-click on the volume for which you want to schedule Space Recovery, and select 
Edit Settings. The Server Agent Volume Properties dialog appears.

5 Click Space Recovery.

6 Click Change.

7 Specify the following:

• Use volume Space Recovery Schedule: Select this option to set a Space 
Recovery schedule for the volume.

• Schedule Space Recovery on this volume: Select this option to set a Space 
Recovery schedule for the volume.

• Run: Select the default schedule run time: Every Day, Once a Week, or Once a 
Month. For Once a Week, select the day of the week to run Space Recovery; for 
Once a Month, select the day of the month to run Space Recovery.

Note Scheduled Space Recovery runs at the time specified on the Server Agent 
Properties dialog. See Enabling Space Recovery and Setting a Global Space 
Recovery Schedule on page 175.

8 Click Apply Changes.
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Removing a Volume from a Space Recovery Schedule
To remove a volume from a Space Recovery schedule:

1 In the Viewers pane, click the Servers icon.

2 Right click on a volume, and select Edit Settings. The Server Agent Volume Properties 
dialog appears.

3 Click Space Recovery.

4 Click Change.

5 Make sure the following options are disabled:

• Clear the Use volume Space Recovery Schedule option.

• Clear the Schedule Space Recovery on this volume option.

6 Click Apply Changes.
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Setting Up Email Notification for Space Recovery
To receive Space Recovery Reports via email:

1 From the Management menu, select User Properties. The User Properties dialog 
appears.

2 Click Manage Events.

3 Click Change.

4 Make sure Space Recovery Report is selected. 

5 Click Apply Changes. 
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Running Space Recovery
To run Space Recovery immediately:

1 In the Viewers frame, click the Servers icon.

2 Right-click on a volume, and select Run Space Recovery. 

3 Click Yes to run Space Recovery.

The system notifies you when Space Recovery is finished. For information on scheduling 
automatic Space Recovery, see Scheduling Automatic Space Recovery on page 174.
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Viewing Space Recovery History

 To view Space Recovery History for all servers
1 In the Viewers pane, click the Servers icon.

2 Right-click on the Server Agents folder, and select Space Recovery History.

3 Click OK to close the display.

 To view Space Recovery History for all volumes on a server
1 In the Viewers pane, click the Servers icon.

2 Right-click on a server, and select Space Recovery History.

3 Click OK to close the display.

 To view Space Recovery History for a volume
1 In the Viewers pane, click the Servers icon.

2 Right-click on a volume, and select Space Recovery History.

3 Click OK to close the display.
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Viewing Server Agent Information

Viewing Information for All Server Agents
To view all Server information:

1 In the Viewers pane, click on the Servers icon.

2 In the navigation pane of the Servers Viewer, click on the Servers icon.

3 At the top right of the display, select the information you want to display from the pull-
down menu: 

Show Servers and Volumes: Shows information for all servers and volumes.

Show Servers: Shows server information only.

Show Volumes: Shows volume information only.

Information on the selected objects is displayed.

Viewing Information for an Individual Server
To view information for an individual server:

1 In the Viewers pane, click on the Servers icon.

2 Click on an individual server. Information for the server appears. Information includes 
Operating System View, Server HBAs, and Volumes.

Viewing Server Information in the Storage Management Window
To view server information in the Storage Management window:

1 In the Viewers pane, click on the Servers icon.

2 Right-click on a server, and select a Storage Center node, and then select Show in 
Storage Management Tab. 

3 If the Reporting Time Filter dialog appears, select the Starting Time and Ending Time, 
and click OK. 

Server information is displayed in the Storage Management window. 

Viewing Server Information in the IO Usage Tab
To view server information in the IO Usage Report window:

1 In the Viewers pane, click on the Servers icon.

2 Right-click on a server, select a Storage Center node, and then select Show in IO 
Usage Tab. 

3 If the Reporting Filter dialog appears, select the Starting Time and Ending Time, and 
click OK. 

Server information is displayed in the IO Usage Report window.
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Viewing Server Information in Storage Center Manager
To view server information in Storage Center:

1 In the Viewers pane, click on the Servers icon.

2 Right-click on a server, select a Storage Center node, and then select Show in Storage 
Center Manager. 

Enterprise Manager automatically logs into the Storage Center and displays the General 
server information for that server.
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Viewing Server Volume Information
To view volumes managed by the server:

1 In the Viewers pane, click on the Servers icon.

2 Click on a volume. Information for that volume appears.

Volume View includes:

• Volume name and mount point

• Volume label

• Multipath policy (for multipathed volumes only)

• Server on which this volume is mounted

• Last update

• Time last space recovery was run

• Space Recovery schedule

Storage Center View includes:

• Name of the volume

• Configured space

• Used space 

• Free Space 
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Viewing and Managing a NAS or zNAS Server
You can monitor and manage a Storage Center NAS or zNAS server via Enterprise 
Manager. To do so, you must install and register a Dell Compellent Server Agent on the 
server. 

• For information on Storage Center NAS, refer to the Storage Center NAS Storage 
Solution Setup Guide and the Storage Center NAS Storage Solution User Guide.

• For information on Storage Center zNAS, refer to the Dell Compellent zNAS User Guide 
and Dell Compellent zNAS System Setup Guide

• For information on installing Server Agents, refer to the Enterprise Manager Installation 
and Setup Guide.

• For information on registering a server agent, see Registering a Server on page 168.

To view NAS server information:

1 In the Viewers pane, click Servers to display Servers.

2 Click on a NAS or zNAS server. 
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Server Information Tab

The Server Information tab for a NAS displays the following:

• Server Agent Information: Shows the operating system, IP address, Server Agent 
version, Index, Last Update, Space Recovery Support, VDS Manager version (if 
installed), and Replay Manager version (if installed).

• Server HBAs: Lists all the HBAs associated with the server.

• Storage Information: Lists all volumes on the NAS, along with storage statistics for the 
volume.
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NAS Tab

The NAS tab display shows the following:

• Current State: If the NAS is powered on, displays a series of tabs that display the 
current state for each sensor: Fan Speed, Temperature, Voltage, and Power Supply.

• Historical Stats: For each sensor, shows historical statistics.

• Alerts: If the NAS has issued alerts, shows a table of all current NAS alerts.

NAS Control Options
NAS controls include the following:

NAS Option Description

Clears all entries in the system event log.

Powers off the NAS.

Resets the NAS.

Refreshes information in the NAS display.



189 

Server Agent Properties Dialog

Server Agent Properties Dialog
To view Server Agent properties:

1 From the Management menu, select Data Collector Properties.

2 Click Server Agent. The Server Agent Properties dialog appears.

Gather Server Agent information automatically every hour: Gathers server agent 
information every hour. If this option is not selected, Server Agent will not gather 
information.

Gather stats for last [ ] days: Specifies the number of days for which Server Agent 
should gather historical statistics.

Allow Data Collector to automatically run Space Recovery: Enables automatic 
(scheduled) Space Recovery on all servers and volumes. If not selected, Space 
Recovery schedules are disabled for all servers and volumes.

Run Space Recovery at: Specify the time at which to run Space Recovery.

See Also

Enabling Space Recovery and Setting a Global Space Recovery Schedule on page 175

Scheduling Space Recovery for All Volumes on a Server on page 176

Allowing a Volume to Schedule Space Recovery on page 177

Scheduling Space Recovery for an Individual Volume on page 178
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Server Agent Server Properties Dialog
To view server properties:

1 In the Viewers pane, click the Servers icon.

2 Right-click on a server, and select Edit Settings. The Server Agent Server Properties 
window appears.

General
The General properties displays information for the selected server:

• Host/IP, Port, and IP Address for the server.

• Name or the server.

• Operating system and service pack for the server.

• Domain for the server.

• Number of cluster nodes on server.

• Automatically Manage on Storage Center: When selected, the server is automatically 
created and managed on the Storage Center.

Space Recovery

Note The Space Recovery tab displays only on Windows Servers on which a Server Agent 
for Microsoft Servers is installed and running.

The Space Recovery properties provides the following options:

Note Automatic Space Recovery options for a server are available only when allowed by 
the Server Agent Properties Space Recovery settings. See Server Agent Properties 
Dialog on page 189. 

• Allow volumes on this server to schedule Space Recovery: Allows individual 
volumes on this server to schedule Space Recovery.

• Set default Space Recovery schedule for volumes on this server: Sets a default 
Space Recovery schedule for all volumes on this server.

• Run: Select the default schedule run time: Every Day, Once a Week, or Once a Month. 
For Once a Week, select the day of the week to run Space Recovery; for Once a Month, 
select the day of the month to run Space Recovery.

Note Scheduled Space Recovery runs at the time specified on the Server Agent 
Properties dialog. See Enabling Space Recovery and Setting a Global Space 
Recovery Schedule on page 175.

• Apply server settings to all volumes on this server: Applies the new settings to all 
volumes on the server.
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Storage Center Servers
The Storage Center Servers tab allows you to manually map a server agent server to a 
server on one or more Storage Centers.

• Add: Allows you to select a server on a Storage Center to map to the server agent. 

• Remove: Allows you to remove a mapping to a Storage Center server.

See Also

Manually Mapping a Server Agent to a Storage Center Server on page 169

Parent Folder
The Parent Folder tab allows you to select a parent folder for the server.

See Also

Enabling Space Recovery and Setting a Global Space Recovery Schedule on page 175

Scheduling Space Recovery for All Volumes on a Server on page 176

Allowing a Volume to Schedule Space Recovery on page 177

Scheduling Space Recovery for an Individual Volume on page 178

Creating Folders for Servers on page 170

Moving a Server to Another Folder on page 171
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Server Agent Volume Properties Dialog
To view volume properties reported by the server:

1 In the Viewers pane, click on the Servers icon.

2 Right-click on a volume, and select Edit Settings. The Server Agent Volume Properties 
dialog appears.

General
The Server Agent Volume Properties General tab displays:

• Volume name

• Volume label

• Volume serial number

Space Recovery

Note The Space Recovery tab displays only for volumes on Windows Servers on which a 
Server Agent for Microsoft Servers is installed and running.

The Space Recovery tab provides options for setting up Automatic Space Recovery.

Note Automatic Space Recovery options for a volume are available only when allowed by 
the Server Agent Server Properties Space Recovery settings. See Server Agent 
Server Properties Dialog on page 190. 

• Use Servers Space Recovery schedule: Uses the server schedule for Space 
Recovery if a server schedule is set.

• Schedule Space Recovery on this volume: Allows you to define a volume schedule 
for Space Recovery.

• Run: Specifies the volume Space Recovery schedule. Options include Every Day, Every 
Week, or Once a Month.

Note Scheduled Space Recovery runs at the time specified on the Server Agent 
Properties dialog. See Enabling Space Recovery and Setting a Global Space 
Recovery Schedule on page 175.
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See Also

Enabling Space Recovery and Setting a Global Space Recovery Schedule on page 175

Scheduling Space Recovery for All Volumes on a Server on page 176

Allowing a Volume to Schedule Space Recovery on page 177

Scheduling Space Recovery for an Individual Volume on page 178
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Preparing for Disaster Recovery

Automatically Save Restore Points
To automatically save restore points:

1 From the Options menu, choose Replication Recovery > Save Restore Points. The 
Save Restore Points wizard appears.

2 Select the Storage Centers for which you want to save restore points, and click Next. 
Enterprise Manager saves restore points for the selected Storage Centers. When the 
restore points have been saved, the Save Restore Points wizard displays a summary 
screen.

3 Select the following:

Automatically Save and Validate Restore Points: Enable this option to automatically 
save and validate restore points.

Check Every: Select the interval at which you want to save restore points: Once a Day, 
12 hours, 4 hours, or Hour.

At Time: For Once a Day, set the time of day to save restore points.

4 Click Finish.

Predefine a Disaster Recovery Site
Predefining a disaster recovery site consists of assigning destination servers and Replay 
templates to destination volumes ahead of time, so that if you must activate a disaster 
recovery, the recovery site is ready. (If you do not intend to access data from a destination 
site, you do not need to predefine the disaster recovery site.)

1 From the Options menu, choose Replication Recovery > Predefine Disaster 
Recovery Site. The Predefine DR Site Wizard appears listing saved Replication 
points.

2 Select a source and destination system pair.

3 Click Next. A list of volume Replications appear.

4 For each volume:

a Click Edit Settings, and select settings for the destination site.
b Click OK.

5 When you have finished selecting settings for each volume, click Finish. 
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Test Disaster Recovery
Dell Compellent recommends that you periodically test a Disaster Recovery site. 

To test a Disaster Recovery site:

1 From the Options menu, select the Replication Recovery > Test Activate Disaster 
Recovery Site. The Activate wizard appears, displaying source and destination 
systems of saved Replications.

2 Select a source and destination pair.

3 Click Next. 

4 Select Test Activation and click Next. 

5 From the list of volumes that can be tested, select volumes to test.

6 Click Next. The system displays the volumes you selected. Volumes that were 
predefined are ready to be restored. If a volume is not predefined, define a volume by 
following these steps: 

For each volume:

a Click Edit Settings, and select options for the destination volume.
b Click OK. 

7 Click Next. Enterprise Manager creates a View Volume from the last Replay on the 
Destination system. The system displays the restoration progress. When the test is 
complete, click Finish. You can see the View Volume by right-clicking on the Destination 
system in the Storage Centers frame. From the shortcut menu, select View > Storage 
Management. Expand the Volumes folder. The tested volume appears as DR View of 
Replication of [volume name].
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Activating Disaster Recovery

Note For instructions on testing DR activation, see Test Disaster Recovery on page 197.

If a Source volume fails, activate Destination Site Replication Volume. To activate 
Disaster Recovery:

1 From the Options menu, select Replication Recovery > Activate Disaster Recovery 
Site. The Activate wizard appears, displaying source and destination systems of saved 
Replications.

2 Select the source and destination of volumes that are no longer active and click Next. 

3 Select Activate the Destination System, and click Next. The Activate DR Replication 
volumes window appears. In the top table, the system displays volumes that are still 
Replicating and do not need to be restored. In the second table, the system displays 
volumes that can be restored. 

4 From the list of volumes that can be restored, select volumes to restore.

5 Click Next. The system displays the volumes you selected. Volumes that were 
predefined are ready to be restored. If a volume is not predefined, define a volume by 
following these steps:

For each volume:

a Click Edit Settings, and select options for the destination volume.
b Click OK. 

6 Click Next. The system displays the restoration progress. When Restoration is 
complete, click Finish. You can see the restored volume by right-clicking on the 
destination system in the Storage Centers frame. From the shortcut menu, select View 
> Storage Management. Expand the Volumes folder. The volume appears as a 
Replicated volume.
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Restarting or Recovering to the Source Site
For a Replication to be restarted or a Replicated volume to be restored, the Restore point 
must be saved. Refer to Saving and Validating Replication Restore Points on page 110.

Restarting a Replication
If a Source volume is in a good state and the destination system is available but a 
Replication failed or was deleted, you can restart the Replication. To see if a Replication 
can be restarted, validate Restore Points (see Validating Replication Restore Points on 
page 115).

To restart a Replication:

1 From the Options menu, select Replication Recovery > Recover/Restart 
Replication Volumes Back to Original System. The Restore/Restart wizard appears 
with a list of Source and Destination systems and Saved Replication Points.

2 Select Source and Destination System pair and click Next. A warning message 
appears. Make sure you understand the rules for restarting a Replication.

3 Click Next. 

4 At the top, the system displays volumes that are still Replicating and do not need to be 
restarted. At the bottom, the system displays volumes that can be restored. From the 
bottom list, select a Replication volume to be restarted. 

5 Click Next. The Select Attributes window appears. To limit the number Replications to 
restart at once, enter a Maximum Number of Restores. To restart all Replications at 
once, enter 0. The system restarts Replications starting at the top of the list. Use the up 
and down arrows to move a volume up or down.

6 Click Next. Because the Restore Points were saved, the system re-creates the original 
Replication and displays the progress of the Restorations. 

7 When the Replications are successfully restarted, click Next. The system advises you 
to save the Replication Recover State.

8 Click Save Replication Recover. The Save Replication Recover wizard appears. 

9 Click Next. The system saves the restore points for the selected system. 

10 Select Do a Daily Save and Validate Replications. Click Finish. The Replication is 
restarted and the restore points are saved. To view the restarted Replication, in the 
Viewers frame, click Replications.

Restoring a Failed Volume
Before a volume can be restored, at least one Replay must have been Replicated to the 
Destination system. 

Non-active Disaster Recovery system: If a Source volume no longer exists, Enterprise 
Manager restores the data from the Destination volume by Replicating it back to a newly 
created Source volume. Once the Replication is complete, EM maps the new source 
volume to a selected server and restarts the Replication back from the Source system to 
the Destination system.
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Recover from a Destination Volume that was activated: Enterprise Manager recovers 
data from the Destination volume, including all new writes to the volume after it has been 
activated, to the original Source volume. If the original Source volume is no longer there it 
will be re-created. Once the Restore is complete, Enterprise Manager maps the Source 
volume to the selected server and restarts the Replication from the Source volume to the 
Destination volume.

To restore a failed volume:

1 From the Options menu, select Replication Recovery > Recover/Restart 
Replication Volumes Back to Original System. The Restore/Restart wizard appears 
with a list of Source and Destination systems and Saved Replication Points. 

2 Select Source and Destination System pair and click Next. A warning message 
appears. Make sure you understand the rules for restoring a Volume.

3 Click Next. 

4 At the top, the system displays volumes that are still Replicating and do not need to be 
restarted. At the bottom, the system displays volumes that can be restored. From the 
bottom list, select a Replication volume to be restarted. 

5 Click Next. The system displays volumes that need to be restored. 

a Select a volume, and click Edit Settings.
b Edit settings for the volume, and click OK.

If Automatically Restart Replication is selected, Enterprise Manager 
automatically restarts the Replication from the source system back to the 
Destination system.

If Restore from Last Replay is selected, the volume is restored from the last active 
Replay on the Destination system not from the active data on the Destination 
volume. This assures that the volume is restored to its original source state.

6 Click Next. The Select Attributes window appears. To limit the number volumes to 
restore at once, enter a Maximum Number of Restores. To restore all volumes at 
once, enter 0. The system restores volumes starting at the top of the list of volumes. Use 
the up and down arrows to move a volume up or down.

7 Click Start. The system displays the progress of the volume restoration. 

8 When the system notifies you that the volumes have been restored, click Next. The 
system recommends that you save the Replication recover state. 

9 Click Save Replication Recover State. 

10 Select the original source system to save the Replication Recovery point. The system 
informs you that the Restore Points are saved. 

11 Click Next. The system saves the restore points for the selected system. 
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12 Select Do a Daily Save and Validate Replications. Click Finish. The volume is 
restored. You can view the restored volume by right-clicking on the Source system in 
the Storage Centers pane.

13 From the shortcut menu, select View > Storage Management. Expand the Volumes 
folder. The Restore volume appears in the folder you selected. 

If a restore needs to be done from a DR-activated site, the Delete Source Volume window 
appears. If you did not select to automatically delete Source volumes, you can optionally 
delete the original source. 
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Restoring to an Alternate Site
Do not use the Restore Replications command to move volumes to another system. Refer 
to Moving Volumes on page 112.

To restore a volume to an alternate site, consult with Dell Support Services (see http://
support.dell.com/compellent).

http://www.support.dell.com/compellent
http://www.support.dell.com/compellent
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Introduction
A remote Data Collector provides access to Enterprise Manager DR options when the 
primary Data Collector is unavailable. If installed and connected to the primary Data 
Collector:

• A client connected to the primary Data Collector displays the remote Data Collector 
status using the Remote Data Collector Viewer. 

• A client connected to the remote Data Collector displays only the remote Data Collector. 
This chapter describes how to connect and use the remote Data Collector.

Note For information on installing, connecting, and disconnecting a Remote Data 
Collector, refer to the Enterprise Manager Installation and Setup Guide.
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Logging on to the Remote Data Collector
If the primary Data Collector is unavailable, you can perform Enterprise Manager DR tasks 
via the remote Data Collector. To log on to the remote Data Collector:

1 Start the Enterprise Manager client.

2 On the logon screen, specify the following:

• User/Password: Enter an existing Enterprise Manager username/password. If 
enhanced security is enabled, the username must be a member of the administrator 
group.

• Create New Connection: If you need to establish a new connect for the remote Data 
Collector, enable this option to create a new connection.

• Name or Host IP: Enter the host name or IP address of the server running the 
remote Data Collector.

• Port: Enter the port the Data Collector is using in the Port Field. The port is set when 
the Data Collector is installed. The default port is 7342.

3 Click Login. 
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Setting Up Events for the Remote Data Collector
To set up events on the remote Data Collector:

1 Start the Enterprise Manager client and log on to the remote Data Collector.

2 From the Management menu, select User Properties.

3 On the Email tab, enter an email address to which you want Enterprise Manager to send 
event alerts.

4 On the Manage Events tab, enable the events for which you want to receive emails:

Storage Center Down: Sends an email whenever a Storage Center is no longer able 
to communicate with the primary Data Collector.

Remote Data Collector Down: Sends an email whenever the primary Data Collector 
is no longer communicating to the remote Data Collector.

5 Click OK. 
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Using DR Options from the Remote Data Collector Viewer 
To use DR options from the Remote Data Collector Viewer:

1 Start the Enterprise Manager client and log on to the primary Data Collector.

2 In the Viewers frame, click Remote Data Collector Viewer.

3 Verify that the Remote Data Collector state is Connected.

4 Select the DR task to perform:

Note DR options available via the Remote Data Collector function the same as the DR 
options available via the Options menu. 

Test Activate DR Site: See Test Disaster Recovery on page 197.

Activate DR Site: See Activating Disaster Recovery on page 198.

Validate Restore Points: See Automatically Save Restore Points on page 196.
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Using DR Options from the Remote Data Collector
If the primary Data Collector is unavailable:

1 Start the Enterprise Manager client and log on to the Remote Data Collector.

2 Select the DR task to perform:

Note DR options available via the Remote Data Collector function the same as the DR 
options available via the Options menu. 

Test Activate DR Site: See Test Disaster Recovery on page 197.

Activate DR Site: See Activating Disaster Recovery on page 198.

Validate Restore Points: See Automatically Save Restore Points on page 196.
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Removing a Remote Data Collector
To remove a remote Data Collector:

1 On the remote Data Collector server:

a Open the Remote Data Collector Manager.
b Click Stop to stop the service.

2 Start the Enterprise Manager client and log on to the primary Data Collector.

3 In the Viewers frame, click Remote Data Collector.

4 When the Remote Data Collector Viewer shows Not Connected, click Remove 
Remote Data Collector.
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Introduction
The VMware Site Recovery Manager (SRM) supports storage vendors via Storage 
Replication Adapters (SRA), also called SRA plugins. The Enterprise Manager SRA allows 
sites to use VMware Site Recovery Manager (SRM) on Dell Compellent Storage Centers.

This appendix provides an overview of using SRM on Storage Centers via Enterprise 
Manager and the Enterprise Manager SRA. In addition, this appendix provides a procedure 
for failback to the original protected site after a failover to the recovery site has occurred.

For complete information on installing and configuring VMware Site Recovery Manager 
(SRM) refer to the Administrator Guide for Site Recovery Manager available from VMware.
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Enterprise Manager SRA Requirements

Note When you install the Enterprise Manager Storage Replication Adapter (SRA) for 
VMware Site Recovery Manager (SRM), check the readme file for the most up-to-
date information regarding installing and setting up SRM with the Enterprise 
Manager SRA.

Software Requirements
• Storage Center version 4.0 (or above)

• Enterprise Manager version 3.3 (or above)
An Enterprise Manager Data Collector can be installed on only the recovery site or on 
both the protected and the recovery site.

• VMware Site Recovery Manager 1.x/4.x (or above)

• Microsoft .Net Framework version 2.0

• Port 8080. The Enterprise Manager SRA uses SOAP protocol over http to connect to 
the Enterprise Manager. The port gets set up when configuring Enterprise Manager and 
the default is port 8080. Because SOAP is used, you must configure the firewall (if any) 
between SRM and the Enterprise Manager to keep the corresponding port open.

VMware SRM Configuration Requirements

Note For complete information on installing and configuring VMware Site Recovery 
Manager, refer to the Administrator Guide for Site Recovery Manager available from 
VMware.

Site Recovery Manager must be configured with both a protected (primary) site and a 
recovery (secondary) site. Both the protected and recovery sites must include:

• VMware License Server (ESX 3.5 only)

• VMware vCenter Server

• VMware Site Recovery Manager

• VMware ESX Servers

• Dell Compellent Storage Centers
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Enterprise Manager and Replication Prerequisites
The following table lists prerequisites for using the Enterprise Manager SRA with VMware 
Site Recovery Manager (SRM).

Note For information on setting up replications and saving restore points, see Creating 
Replications on page 109 and Saving and Validating Replication Restore Points on 
page 110.

Requirement Description

Data Collector An Enterprise Manager Data Collector must be visible to all Storage 
Centers within the SRM configuration. There are two possible 
configuration options:

• Install and configure the Enterprise Manager Data Collector on 
the recovery SRM site only.

or

• Install and configure Enterprise Manager Data Collectors on both 
the recovery and protected SRM sites.

Replications Using Enterprise Manager, create replications between the protected 
and recovery sites.

Restore Points Using Enterprise Manager, save restore points for the replications. If 
you are using Data Collectors on both the recovery and protected 
sites, you must save restore points on both sites.
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Enterprise Manager SRA Configuration
The Enterprise Manager SRA must be set up to connect to the Data Collector on which 
replication restore points are saved.

To configure the Enterprise Manager SRA:

1 Enter the following information on the SRM Add Array Manager dialog:

2 After entering the array information, click Connect to test the connection.

Field Description

Display Name Enter a name for the SRA to display in the Site Recovery Manager 
(SRM) Viewer.

Manager Type Select Enterprise Manager SRA.

IPAddress:WebServices Port Enter the IP Address of the Enterprise Manager Data Collector 
and the Web Services port separated by a colon (:). The default 
Web Services port is 8080. If you use the default port, you can omit 
the port. For example, the following are all valid entries:

172.31.2.125:8080
172.31.2.125
172.31.2.125:8081

Username Enter the username of the Enterprise Manager.

Password Enter the password for the Enterprise Manager username.
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SRM Failback Procedure

Note A failback to the protected SRM server can be performed only after a successful 
failover to the recovery SRM server. 

Failback Task Details

Prepare the protected SRM 
server for failback

On the protected site:

1. Log into the VI client.
2. Remove the virtual machines from the inventory.
3. Open the SRM tab.
4. Remove all the protection groups.

Prepare the recovery SRM server 
for failback

On the recovery site:

1. Log into the VI client.
2. Power down all running virtual machines to which you want 

to fail back.
3. Open the SRM tab.
4. Remove all configured recovery plans.

Prepare the Storage Center for 
failback

1. Log into the Storage Center on the protected site, and delete 
the original replications.

2. Log into Enterprise Manager, and delete the original restore 
points.

Note If you have an Enterprise Manager Data Collector 
running on both the protected and recovery sites, delete 
restore points on both the protected and the recovery 
sites.

Set up replications from the 
recovery site to the protected site

Using Enterprise Manager:

Note Before a replication can start, there must be at least one 
Replay on the volume to be replicated. 

1. Create a replication from an existing volume on the Storage 
Center in the recovery site to the Storage Center in the 
protected site. By default, the replicated volumes are named 
DR View of [Name of original replicated volume].

2. Save restore points for the new replications. 

Note If you have an Enterprise Manager Data Collector 
running on both the protected and recovery sites, save 
restore points on both the protected and recovery sites.

Wait for replications to complete Before continuing to the next step, wait until Enterprise Manager 
reports that the replications are complete. If necessary, continue 
to refresh the view to see the status of the replications.
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SRM Failback Procedure

Set up SRM for failback On the recovery site:

1. Log into the VI client.
2. Open the SRM tab. 
3. Create protection groups for the new replications. By default, 

the replicated volumes are named DR View of [Name of 
original replicated volume].

Note You may need to rescan the arrays. To do so, open the 
Array Manager configuration screen, click through the 
first two screens, and then click the Rescan Arrays 
button.

On the protected site:

1. Log into the VI client.
2. Open the SRM tab. 
3. Create recovery plans for the new protection groups.

Test the recovery plans On the protected site:

1. In the VI client, open the SRM tab.
2. Test the recovery plan you created. 

Fail back to the protected SRM 
server (run the recovery plan)

On the protected site:

• In the VI client, run the recovery plan. 

Note Running the recovery plan automatically shuts down all 
running virtual machines on the recovery site.

Clean up the SRM servers On the recovery site:

1. Log into the VI client.
2. Remove from the inventory all the virtual machines that you 

failed over.
3. Open the SRM tab.
4. Remove the protection groups.

On the protected site:

1. Log into the VI client.
2. Open the SRM tab.
3. Remove the recovery plan(s) you created.

Failback Task Details
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Clean up Storage Center and 
Enterprise Manager

1. Log into the Storage Center on the recovery site.
2. Remove the replications (replications should be down).
3. Log into Enterprise Manager.
4. Delete the restore points for the replications.

Note If you have an Enterprise Manager Data Collector 
running on both the protected and recovery sites, delete 
restore points on both sites.

5. On the recovery Storage Center, unmap the volume to 
recovery ESX server.

Restart replications Using Enterprise Manager:

1. Create a replication from an existing volume on the protected 
Storage Center to the recovery Storage Center.

2. Save restore points for the replications.

Note If you have an Enterprise Manager Data Collector 
running on both the protected and recovery sites, save 
restore points on both sites.

Prepare SRM On the protected site:

1. Log into the VI client.
2. Open the SRM tab.
3. Create protection groups for the replicated virtual machines.

On the recovery site:

1. Log into the VI client.
2. Open the SRM tab.
3. Create a recovery plan(s) for the protection groups.

Failback Task Details
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Glossary

A

activate disaster recovery

Process of mapping a remote file to a server so that you can use it to run IO through.

active space

Amount of space that is used by a volume if the volume has no Replays attached to it. This 
number does not include RAID overhead.

actual space

Amount of active space plus Replay space.

assigned Disks

Disks that have been assigned to a folder and are part of the Storage Center page pool.

async/asynchronous Replication

A Write is written to the local system, then queued for delivery to the remote system. If the 
local system fails before the write is delivered, it is possible that Writes will not get delivered 
to the remote system. Note that Storage Center Data Instant Replay, which takes frequent 
point-in-time copies, mitigates loss of data.

available space

Amount of total storage available on all drives.

B

backup

Migration of data from a primary storage source to a secondary storage source to enable 
restoration of primary data in the event of a failure.

bandwidth

Amount of data that can be sent to or from Storage Center per internal time.
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base price

Agreed upon price for basic storage

BE (back end)

Connection between controller and disks

C

cache

A high speed memory or storage device used to reduce the effective time required to read 
data from or write data to a lower speed memory or device. Dell Compellent provides 2.5 
GB of cache to minimize disk latencies. Storage Center cache has a 72 hour battery backup 
in the event of power loss.

CHAP (Challenge Handshake Authentication Protocol)

An option for authentication of iSCSI communications, particularly between two Storage 
Centers when Replicating over iSCSI.

client

Dell Compellent Enterprise Manager component that manages and displays Storage 
Centers.

Copilot Services

Combination of centralized support, product education and sales resources that proactively 
monitor the system and recommend corrective actions to improve performance and 
availability of the system.

copy volume

Copies data (and volume updates while the copy is in progress) to the remote volume. 
When the copy is complete, the Replication is complete.

D

Data Collector

Dell Compellent Enterprise Manager component that runs in the background on a server, 
collecting information on all Storage Center systems connected to the server.

Data Instant Replay

Captures a point in time copy (PITC) of a volume, based on defined intervals, providing the 
ability to roll back a volume to a previous point in time.

Data Progression

Automatically migrates data to higher or to lower performance devices, based on data 
access requirements.
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deduplication

Copies only the changed portions of the Replay history on the source volume, rather than 
all data captured in each Replay. 

destination system

Storage Center system that volumes are being replicated to - same as Target System.

disk folder

A collection of physical disks that can be assigned attributes by the user. Performance is 
improved by maximizing the number of disk drives in a folder. Volumes draw storage from 
disk folders. Folders may be associated with multiple page pools.

E

enclosure

A physical enclosure that provides a single interface, power and cooling to multiple disks. 
Also known as Just a Bunch of Disks (JBOD).

F

FC (Fibre Channel)

High-speed, fully duplexed serial communication protocol permitting data transfer rates of 
up to 2 Gigabit per second with a roadmap extending up to 10 Gigabit.

FE (front end)

Connection between controller and server.

free space

Total available space minus used space.

H

HBA (Host Bus Adapter)

An I/O adapter that provides connectivity from a server to the Storage Center.

I

IO (input/output)

Moving data into a system memory, and moving data from system memory to another 
location.

IO pending

Amount of IO operations that are currently in the queue to be run for an object.
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IO usage

Speed at which data is being transferred.

iSCSI

Specification that defines the encapsulation of SCSI packets over Ethernet using the TCP/
IP transport protocol.

J

JDBC

An Application Programing Interface (API) for the Java programming language that defines 
the way in which a client accesses a database. 

L

latency

Delay in data transmission measured in milliseconds.

M

management controller

In a clustered-controller environment, the port that is communicating with the server.

migrate volume

Copies data to a new volume, and then erases the original volume. Migrate has the same 
effect as moving a volume.

mirror volume

Copies volume data to the remove site and maintains updates between the local volume 
and the remote volume until the mirror is manually broken.

N

NAT (Network Address Translation)

Also known as network masquerading or IP masquerading. NAT involves rewriting the 
source or destination addresses of IP packets as they pass through a router or firewall. 
Most systems use NAT to enable multiple hosts on a private network to access the Internet 
using a single public IP address.

O

object

In Chargeback, defines what logical components of a system are monitored, such as a 
system, volume folder, or volume.

/wiki/Java_(programming_language)
/wiki/Java_(programming_language)
/wiki/Database
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oversubscribed space

Configured space minus available space.

P

page pool

Group of data pages taken from a disk folder. Page pools provide storage for dynamic 
volumes, manage storage allocations, and can have a variety of disk types and RAID 
selections.

price multiplier

In Chargeback: A number applied to the storage costs of this Department. to add a premium 
or discount to a Department.

Q

QoS (Quality of Service)

Rules for Replications, including link speed, number of links, and Replication schedule

R

RAID 0

Data is striped across the available disks providing improved performance. RAID 0 does 
not provide any data redundancy.

RAID 10

Data is striped across available disk drives and mirrored, providing data availability and 
improved performance. Maintains a minimum of one full copy of all data on the volume. 
RAID 10 provides optimum Read / Write performance, increased probability of withstanding 
multiple failures, and the quickest restoration of data.

RAID 5

Maintains a logical copy of the data using a mathematically derived rotating parity stripe. 
The parity stripe is derived from the data stripes. This method has less overhead for the 
redundant information than RAID 10 however write performance is slower than RAID 10 
due to the calculation of the parity stripe for every write. Read performance is similar to 
RAID 10.

redundancy

Fault tolerance such that if some disks fail, all or part of the data stored by the array is not 
lost. The cost of providing this feature is most typically increased disk space; RAID 10 
requires a duplication of the entire data set. RAID 5-5 and 5-9 contain an error-correcting 
algorithm stored on the array.

Remote Instant Replay

Point-in-time copy of a volume over a distance to a remote site. The sites can be active-
active, with bidirectional remote copies that can either have matched or split intervals.
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Replay

Fully usable copy of data that contains an image of the data as it appeared at the point in 
time at which the copy was initiated.

Replay space

Amount of space that is not actively being used by a volume and is contained in its Replays. 
This number does not include RAID overhead.

Replay profile

Collection of Replay rules that can be used for creating a Replay.

replicating system

Storage Center system being Replicated.

replication

Data backup to a remote location, online and in real time, via the internet or a corporate-
leased line connection

restore points

Information stored by the Data Collector about the current state of Replications between 
Storage Centers, including what volumes are being replicated, to where, what QoS node 
Replications are using, and Source volume properties

S

SCSI (Small Computer Systems Interface)

Collection of ANSI standards which define I/O buses primarily intended for connecting 
storage devices to servers.

server

Name representing the actual WWNs installed on the server.

Space Recovery

Utility that recovers space that Windows reports as being used but is actually empty, 
available space that can be used by Storage Center.

spare disks

Disk reserved to replace a disk of same or smaller size in the event a disk in RAID 5 logical 
unit fails. The controller rewrites the data from the failed disk to the replacement disk on the 
fly.

starting base price

In Chargeback: The actual amount of storage that the base price covers before the 
Department is charged for storage.
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Storage Center

Dell Compellent SAN system, consisting of a controller and a disk enclosure.

storage usage

Amount of space consumed by volumes on the disk (including Replays and RAID 
overhead).

synch (Synchronous Replication)

Each Write written to the local site is written to the remote site before the application 
receives an I/O complete message. The local volume and remote volume are fully 
synchronized at all times. This redundancy ensures a near-zero loss of data and very quick 
recovery times from failures at the local site.

T

target system

Storage Center system that volumes are being replicated to threshold alert definition: 
defines what action triggers an alert - can be IO/sec, latency, percentage of total storage 
space used, speed of storage growth, and so forth.

threshold alert object

Defines what logical objects are monitored, such as a system, volume folder, or volume.

total available space

Same as Available Space.

total storage

Actual Space plus the amount of space taken up by RAID overhead.

total storage space

Amount of space the volume takes of actual disk space, including RAID overhead.

U

unassigned disks

Drives not assigned to a folder. Unassigned disks are not unavailable to the system

used space

Storage written to by servers or consumed in Replays.

used space growth rate

Average amount of additional storage consumed per day (in GB). If number is negative, 
storage is being reclaimed for reuse.
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V

volume

A virtual disk drive. A volume is created through and managed by Storage Center software.

W

WWN

World Wide Name.
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